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Copyright
©1999 General DataComm, Inc. ALL RIGHTS RESERVED.

This publication and the software it describes contain proprietary and confidential information
part of this document may be copied, photocopied, reproduced, translated or reduced to an
electronic or machine-readable format without prior written permission of General DataComm
The information in this document is subject to change without notice. General DataComm as
no responsibility for any damages arising from the use of this document, including but not lim
to, lost revenue, lost data, claims by third parties, or other damages.

If you have comments or suggestions concerning this manual, please contact:

Technical Publications Department
General DataComm, Inc.
Park Road Extension
Middlebury, Connecticut  USA 06762-1299

Telephone: 1 203 758 1811

Trademarks
All brand or product names are trademarks or registered trademarks of their respective com
or organizations.
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Safety Guidelines
Always use the following guidelines when unsafe conditions exist or when potentially hazard
voltages are present:

• Always use caution and common sense.

• Repairs must be performed by qualified service personnel only.

• To reduce the risk of electrical shock, do not operate equipment with the cover remove

• Never install telephone jacks in a wet location unless the jack is designed for that loca

• Never touch uninsulated telephone wires or terminals unless the telephone line is 
disconnected at the network interface.

• Never install telephone wiring during an electrical storm.

Antistatic Precautions
Electrostatic discharge (ESD) results from the buildup of static electricity and can cause com
components to fail. Electrostatic discharge occurs when a person whose body contains a st
buildup touches a computer component. The Innovx 553 may contain static-sensitive device
are easily damaged. Proper handling, grounding and precautionary ESD measures are ess
when installing parts or cards. Keep parts and cards in antistatic packaging when not in use or
transport. If possible, use antistatic floorpads and workbench pads.

When handling components, always use an antistatic wrist strap connected to a grounded equ
frame or chassis. If a wrist strap is not available, periodically touch an unpainted metal surface
the equipment. Never use a conductive tool, like a screwdriver or a paper clip, to set switches

FCC Part 68 Compliance
Connection of data communications equipment to the public telephone network is regulated
FCC Rules and Regulations. This equipment complies with Part 68 of these regulations whi
require all of the following:

All connections to the telephone network must be made using standard plugs and telephone
company provided jacks or equivalent. Connection of this equipment to party lines and coin
telephones is prohibited. A label on the component side of the unit’s printed circuit board pro
the FCC Registration number for the unit. If requested, give this information to the telehone
company. To connect the Innovx 553 to the Public Telephone Network, you are required to gi
following information to the telephone comapny:

• FCC Registration Number: TBD

• Facility Interface Codes: 04DU9-BN, 04DU9-DN, 04DU9-1KN, 04DU9-1SN

• Service Order Code: 6.0Y

• Telephone Company jack type: RJ48C

The telephone company may discontinue your service if the unit causes harm to the telepho
network. If possible, you will be notified of such an action in advance. If advance notice is n
practical, you will be notified as soon as possible and will be advised of your right to file a comp
with the FCC. The telephone company may change its communication facilities, equipment,
operations and procedures where reasonably required for operation. If so, the telephone co
will notify you in writing. All repairs or modifications to the equipment must be performed by
General DataComm. Any other repair or modification by a user voids the FCC registration an
warranty.
058R735-V300 GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 iii
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Industry Canada Notification
The Industry Canada label identifies certified equipment. This certification means that the 
equipment meets telecommunications network protective, operation and safety requirement
prescribed in the appropriate Terminal Equipment Technical Requirements document(s). Th
Department does not guarantee the equipment will operate to the user's satisfaction.

Before installing this equipment, users should ensure that it is permissible to be connected 
facilities of the local telecommunications company. The equipment must also be installed us
acceptable method of connection. The customer should be aware that compliance with the 
conditions may not prevent degradation of service in some situations.

Repairs to certified equipment should be coordinated by a representative designated by the s
Any repairs or alterations made by the user to this equipment, or equipment malfunctions, ma
the telecommunications company cause to request the user to disconnect the equipment.

Users should ensure for their own protection that the electrical ground connections of the po
utility, telephone lines and internal metallic water pipe system, if present, are connected tog
This precaution may be particularly important in rural areas.

Caution: Users should not attempt to make such connections themselves, but should conta
appropriate electric inspection authority, or electrician, as appropriate.

Notice: The Ringer Equivalence Number (REN) assigned to each terminal device provides a
indication of the maximum number of terminals allowed to be connected to a telephone inte
The termination on an interface may consist of any combination of devices subject only to th
requirement that the sum of the Ringer Equivalence Numbers of all the devices does not ex

Electromagnetic Compatibility

This Class A digital apparatus complies with Canadian ICES-003.
iv GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 058R735-V300
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Avis D’industrie Canada
L’étiquette d’Industrie Canada identifie le matériel homologué. Cette étiquette certifie que le 
matériel est conforme aux normes de protection, d’exploitation et de sécurité des réseaux d
télécommunications, comme le prescrivent les documents concernant les exigences techniq
relatives au matériel terminal. Le Ministère n’assure toutefois pas que le matériel fonctionne
satisfaction de l’utilisateur.

Avant d’installer ce matériel, l’utilisateur doit s’assurer qu’il est permis de le raccorder aux 
installations de l’entreprise locale de télécommunication. Le matériel doit également être insta
suivant une méthode acceptée de raccordement. L’abonné ne doit pas oublier qu’il est possi
la comformité aux conditions énoncées ci-dessus n’empêche pas la dégradation du service
certaines situations.

Les réparations de matériel homologué doivent être coordonnées par un représentant désign
fournisseur. L’entreprise de télécommunications peut demander à l’utilisateur de débranche
appareil à la suite de réparations ou de modifications effectuées par l’utilisateur ou à cause
mauvais fonctionnement.

Pour sa propre protection, l’utilisateur doit s’assurer que tous les fils de mise à la terre de la 
d’énergie électrique, des lignes téléphoniques et des canalisations d’eau métalliques, s’il y en
raccordés ensemble. Cette précaution est particulièrement importante dans les régions rura

Avertissement: L’utilisateur ne doit pas tenter de faire ces raccordements lui-même; il doit a
recours à un service d’inspection des installations électriques, ou à un électricien, selon le c

Avis: L’indice d’équivalence de la sonnerie (IES) assigné à chaque dispositif terminal indiqu
nombre maximal de terminaux qui peuvent être raccordés à une interface. La terminaison d
interface téléphonique peut consister en une combinaison de quelques dispositifs, à la seul
condition que la somme d’indices d’équivalence de la sonnerie de tous les dispositifs n’excè
5.

La Compatibilité d’ Eléctro-magnetique

Cet appareil numerique de la classe A est conforme a la norme NMB-003 du Canada.

Deutschland
Installations Anweisungen: Installieren Sie die Telefonleitungen nicht während eines Gewitter
Installieren Sie die Telefonleitungen nicht in einem feuchten Raum, auβer die Dose entspricht den
Vorschriften für Feuchträume. Berühren Sie unisolierte Telefonleitungen oder Einrichtungen 
auβer diese sind vom Telefonnetz getrennt. Vorsicht bei der Installierung oder Änderung vo
Telefonleitungen. Achtung: Es gibt keine durch den Benutzer zu wartende Teile im Gerät. Wart
darf nur durch qualifiziertes Personal erfolgen.
058R735-V300 GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 v
Issue 2 Operation Manual



                                           

ournal 

 

e 
EC Declaration of Conformity
We: General DataComm Limited

Molly Millars Lane
Wokingham, Berkshire RG41 2QF, United Kingdom

On behalf of: General DataComm Inc.
1579 Straits Turnpike
Middlebury, CT 06762-1299, U.S.A.

The products to which this declaration relates are in conformity with the following relevant 
harmonized standards, the reference numbers of which have been published in the Official J
of the European Communities.

Electromagnetic Compatibility

EN55022: 1994

Specification for limits and methods of measurement of radio interference characteristics of
information technology equipment.

EN 50082-1: 1992

Generic immunity standard Part 1 Residential, Commercial, and Light Industry.

Safety

EN 60950: 1995 A1 through A3

Low Voltage Directive relating to electrical equipment designed for use within certain voltag
limits.
vi GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 058R735-V300
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Preface

Scope
This manual describes how to install and operate version 3.0.0 of the TEAM 521 software 
application.  The TEAM 521 software is an HP Openview application that employs the Simp
Network Management Protocol (SNMP) to configure and control the operation of GDC 
SpectraComm 521 Data Service Units (DSUs).  

The SC 521 DSU is a DATAPHONE Digital Service (DDS) compatible DSU that is intended t
used in central site applications.  It is compatible with remote DDS units from other manufactu
It supports the greatest range of management capabilities when used in conjunction with GD
equipment at the remote site: an NMS 520 DSU or an NMS 510 DSU.

The TEAM 521 application communicates with its master SC 521 DSUs through a SpectraC
Manager (SCM) card that occupies the SpectraComm shelf with them.  Control by the applic
can extend also to remote DSUs that are connected to the DSUs under its local control.

Operating instructions for the SCM appear in the TEAM Core Operation manual.

This manual assumes a working knowledge of DSU functions and operation.

The information contained in this manual has been carefully checked and is believed to be e
reliable. However, as General DataComm improves the reliability, function, and design of th
products, is possible that information may not be current. Contact General DataComm if you
require updated information for this other General DataComm products.

General DataComm, Inc.
Park Road Extension
Middlebury, Connecticut, USA  06762-1299
Tel:   1 203 758 1811 Toll Free:   1 800 794 8246
058R735-V300 GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 xi
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Revision History
This is the initial issue of TEAM 521 Version 3.0.0. Version 3.0.0 differs from Version 2.1.0 
through the addition of tool bar interface features in the configuration screens and Year 200
compatability.  Version 3.0.0 also fixes a problem which existed with 2.1.0 when configuring a
flash (non-downloadable) version of SC 521 cards.  All features of the product are describe
Chapter 2, Operations  of this manual.

Version 2.1.0 differed from Version 2.0.0 through a variety of small enhancements, and the ad
of a Save to File capability in the Line Statistics function.

Related Publications
The following documents have additional information that may be helpful when using this pro

GDC publication numbers are used to track and order technical manuals.  Publication numb
the following format:

GDC NNNRnnn-000 or GDC NNNRnnn-Vnnn

 The Issue Number only changes when a manual is revised or when a manual is reprinted fo
other reason; it does not automatically change when software version is updated. Other spec
publications such as Release Notes or Addenda may be available.

Issue Number Date Description of Change

01 July 1998 Never Released (Internal Use Only)

02 April 1999 Initial Release

Publication GDC Number

TEAM Core Operation GDC 058R720-V300-01

SpectraComm 521 Data Service Unit Installation and Operation GDC 076R108-000

NNN identifies the product family (e.g. TEAM)

R denotes a technical publication

nnn a number assigned by Technical Publications

000 identifies a hardware product and does not change

Vnnn the software version associated with a product may be updated periodi
xii GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 058R735-V300
Operation Manual Issue 2
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Manual Organization
This manual is divided into the following chapters: 

• Chapter 1, Introduction  describes the TEAM 521 application, the GDC SC521 DSU that y
control with the application, and the TEAM environment in which the application opera
particularly the SCM that enables communication between the application and the DS
controls.

• Chapter 2, Operations  provides directions for accessing the smaller individual applicatio
that are responsible for the TEAM 521 functions.  It describes how to access the funct
from a shelf map window menu bar, and from the Select menu of a DSU front panel dis
The chapter provides full descriptions of the TEAM 521 applications that display read-
windows.  It provides access information for the applications that display read/write wind
and require greater operator interaction.

• Chapter 3, Configuration  provides instructions for accessing the Configuration applicati
and using it to set modem channel operating parameters.  The chapter covers how to 
configuration changes to the DSU or a template at the controller workstation, and defin
parameters you can set.

• Chapter 4, Maintenance  provides instructions for accessing the Maintenance application 
using it to control functions of the DSU.

• Chapter 5, Diagnostics  provides instructions for accessing the Diagnostics application 
window and using it to perform test procedures.

• Chapter 6, NMS 520  provides instructions for use of the NMS 520 applications provided 
configuration, control, and diagnosis of remote NMS 520 DSUs.

• Chapter 7, NMS 510  provides instructions for use of the NMS 510 applications provided 
configuration, control, and diagnosis of remote NMS 510 DSUs.

Document Conventions 
This typewriter font designates output displayed on the terminal 
interface screens, input entered by you, or panel indicators.

This bold font designates window names and menu selections.   

Note Indicates a note. It is something you should be particularly aware of; something not readily
apparent. A note is typically used as a suggestion.

Important Indicates an emphasized note. It is something you should be particularly aware of; 
something not readily apparent. Important is typically used to prevent equipment dama
058R735-V300 GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 xiii
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Safety Information
The CAUTION, WARNING, and DANGER statements that appear throughout this manual a
intended to provide critical information for the safety of both the service engineer and opera
These statements also enhance equipment reliability.

The definitions and symbols for CAUTION, WARNING, and DANGER comply with ANSI 
Z535.2, American National Standard for Environmental and Facility Safety Signs, and ANSI
Z535.4, Product Safety Signs and Labels, issued by the American National Standards Instit

The following examples show the symbols and definitions of CAUTION, WARNING, and 
DANGER as they are used in this manual.

CAUTION Indicates a potentially hazardous situation which, if not avoided, may result i
minor to moderate injury. It may also be used to alert against unsafe practices.

WARNING indicates an imminently hazardous situation which, if not avoided, could res
in death or serious injury.

DANGER indicates an imminently hazardous situation which, if not avoided, will result i
death or serious injury.
xiv GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 058R735-V300
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Service Support and Training

VITAL Network Services, a General DataComm company, is committed to providing the serv
support and training needed to install, manage, and maintain your GDC equipment.

GDC’s VITAL Network Services provides hands-on training courses through VITAL Network 
Services Global Technology Training Services. Courses range from basic data communication
modems and multiplexers, to complex network and ATM systems. Training courses are ava
at our centers in the US, UK, France, Singapore and Mexico, as well as at a customer’s site
more information regarding GDC's VITAL Network Services’ service programs, training cour
or for assistance with your support requirements, contact GDC's VITAL Network Services a
address or phone number listed below, or visit our website at: http//www.vitalnetsvc.com

VITAL Network Services World Headquarters
6 Rubber Avenue
Naugatuck, Connecticut 06770 USA

North America: 1 800 243 1030
1 888 248 4825
1 203 729 2461

Training Information:1 203 729 0271
French Speaking Canada:1 800 361 2552
North America Fax: 1 203 723 5012

1 203 729 7611

VITAL Network Services Regional Sales and Service Offices:

Europe, Middle East, Africa

VITAL Network Services
Molly Millars Close
Molly Millars Lane
Wokingham, Berkshire RG41 2QF UK

Telephone: +44 1189 657200
Training: +44 1189 657240
Fax: +44 1189 657279

Central America, Latin America

VITAL Network Services
Periferico Sur 4225, Desp. 306
C.P. 14210, Mexico D.F., Mexico

Telephone:+52 5 645 2238
Training:+52 5 645 2238
Fax:+52 5 645 5976

Asia Pacific

VITAL Network Services
501 Orchard Road 05-05
Wheelock Place, Singapore 238880

Telephone: +65 735 2123
Training: +65 735 2123
Fax: +65 735 6889

International Calling Code (+)

When calling from outside the country of origin, use the appropriate Interna-
tional Calling Code where the + symbol is shown.
058R735-V300 GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 xv
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Chapter 1:  Introduction

Overview

This manual covers the General DataComm TEAM 521 Unix Application for HP OpenView.  
should be familiar with HP OpenView and with the operation of digital data service units (DS
in order to use this manual effectively.

The TEAM 521 Unix Application is actually a collection of integrated applications for the HP
OpenView Network Management Platform.  The applications use the Simple Network 
Management Protocol (SNMP) to manage GDC SC521 Data Service Unit (DSU) cards, whic
installed in a GDC SpectraComm shelf.

TEAM 521 applications enable you to:

• Configure SC521 DSUs.

• Monitor  the operation of the DSUs through displays of Alarms and DTE Interface States
through a Front Panel display that shows LED indicators as they appear on the front pa
the physical unit.

• Diagnose suspected problems using local and remote loops (with or without an internally
generated test pattern).

It also provides functions for performing the same range of tasks on an NMS 520 or NMS 510
Service Unit (DSU) installed as the remote unit with which the SC521 DSU communicates.

Communications between the TEAM 521 application and the DSUs occurs through a GDC 
SpectraComm Manager (SCM) card installed in the shelf with the DSUs.  The workstation tha
the TEAM 521 application must also be running the TEAM Core application for managing th
SCM.

SC 521 DSU

The SpectraComm 521 Data Service Unit (DSU) is a multi-rate data service unit capable of
operating in standard DATAPHONE Digital Service (DDS), DDS with a secondary channel (D
SC), or 64 kbps clear channel mode.  It can support DTE data rates of 2.4, 4.8, 9.6, 19.2, 56
64.0 kbps.  When equipped with the optional Data Rate Adapter, it also supports asynchrono
rates below 2400 bps, down to 300 bps.

SpectraComm Manager Card

The DSU operates in conjunction with a GDC SpectraComm Manager (SCM) card to provid
comprehensive network management capabilities using the Simple Network Management Pr
(SNMP).  The SC acts as the SNMP agent through which TEAM management applications 
DSUs and other compatible equipment.
058R735-V300 GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 1-1
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All management communications are directed to the SCM card Internet Protocol (IP) addres
SCM card relays commands and responses between management applications and hardwa
components, using a slot addressing scheme to communicate over the SpectraComm shelf
backplane with the other components.  The SCM is transparent to the applications, which o
as though they were communicating directly with the hardware units.  The SCM card is man
by the TEAM Core application, which is also responsible for the Discovery and Mapping func
by which HP OpenView keeps track of the devices being managed.

TEAM 521 Applications

The applications that make up the TEAM 521 manager are grouped on menus under the headings 
Performance, Configuration, Fault, and Misc (Miscellaneous).  Menus for the applications are 
available in two ways:

• From the menu bar of the HPOV Map window when a SC 521 DSU is selected in the wi

• From the Select button on the SC 521 Front Panel display

SC 521 Front Panel displays current status information on the SC 521 DSU by displaying the
of the LED indicators on the front panel of the unit; provides Select button menus by which yo
invoke all other functions of the TEAM 521 manager.  Front Panel is a selection on the Perform
menu in the HPOV Map window menu bar.  You can also launch the Front Panel display from
window by double clicking on the shelf icon of the DSU you need to work with.

The following TEAM 521 applications appear on both the Map window and Select button me

Performance:

• Alarms - furnished detailed information about alarm state changes

• DTE Status - displays information on the status of signals in the DTE interface

• Line Statistics - displays information on network interface functions

Configuration:

• Configure - enables you to configure a selected SC 521 DSU

• Maintenance - enables you to set device specific attributes that are not set as 
configuration options

Fault:

• Diagnose - enables you to run diagnostic tests on a selected SC 521 DSU

The Misc menu in the Map window menu bar contains three selections that do not appear in
Front Panel Select button menu:

• Information - displays application name and revision level; can also be accessed b
clicking on the GDC logo in the Front Panel display.

• Front Panel Poll Rate - enables you to set a default polling interval to be in effect e
time the Front Panel display is opened.

• Note Pad - opens a shell tool on the workstation running the TEAM software.  You
use the shell tool to run a text editor, mail tool, or any other software that resides o
workstation.  The Note Pad application provides this access for keeping records o
system.
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OpenView Information
For information regarding OpenView, refer to your OpenView documentation.

TEAM 521 supports the OpenView capability of selecting multiple icons in a map window in o
to launch the same application window for multiple units simultaneously.  You can select mu
icons either by clicking the dragging to “box” the icons you intend to select, or by clicking on i
individually while holding down the Control and Shift keys.

You can select up to ten icons at a time, and they must all be for the same type of device.
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Chapter 2: Operations

Introduction
The TEAM 521 controller application consists of a group of smaller applications, each devot
a specific aspect of controlling or monitoring the SC 521 Data Service Unit. There are two m
of access to the TEAM 521 applications: the shelf map menu bar, and the Front Panel wind
Select button menus. This chapter describes both. 

There are four applications in the Performance category: Front Panel displays a representa
the DSU front panel that serves both to show the status of the unit’s LEDs and to provide an
interface to the rest of the applications; Alarms displays alarm information in a read-only win
DTE Status displays the status of signals in the DTE interface; Line Statistics displays inform
concerning the functions of the network interface. This chapter fully describes all four of the
applications. 

There are two applications in the Configuration category: Configure and Maintenance. Each
supports read/write windows by which you can review and alter DSU operating parameters.
chapter describes how to access the Configure and Maintenance applications. Instructions fo
the two applications appear in subsequent, individual chapters. 

The Fault menu provides access to the Diagnose application by which you can command th
functions of the DSU and view test results. This chapter describes how to access the Diagn
application. Instructions for using the application appear in a subsequent chapter. 

Three items appear on the shelf map menu bar as Misc (miscellaneous): Information, Front
Poll Rate, and Note Pad. Of the three, only Information can be accessed from the Front Pan
display, and that is done by clicking the mouse on the GDC logo of the Front Panel rather th
through the menu. This chapter describes all three functions. 

Map Window Menu Bar Access
The table on the following page illustrates how the TEAM 521 application functions are arra
on the menu bar at the top of the HPOV Map window. The table shows only the menu selec
for the TEAM 521 applications. The map window menus include selections in addition to thos
apply to TEAM 521 because the window also provides access to other applications. 

You must select the DSU you intend to work with before you open the menu you intend to u
Select the DSU by clicking the mouse once on its icon in the shelf map.
058R735-V300 GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 2-1
Issue 2 Operation Manual



Operations Common Window Features

elect 
ith the 

mber 
The Performance menu Front Panel selection opens the Front Panel display window. The S
button menus in the Front Panel display window include the selections that appear above, w
exceptions of Front Panel under Performance and the Misc category. 

Common Window Features
Each TEAM 521 application you select opens an on-screen window in which to operate. A nu
of features are common to many of the windows: 

Menu Bar Menu Selections

Performance

Front Panel

Alarms...

DTE Status...

Line Statistics...

Configuration

Configure...

Maintenance...

Fault

Diagnose...

Misc

Information...

Front Panel Poll Rate...

Note Pad

Triangle button – in the title bar; reduces the window to an icon when you click on it. Double clicking on 
icon restores the window. This button appears on the top level window for each 
application

Title bar – identifies the specific TEAM 521 application running in the window; for example TEAM 
521 Main Configuration or TEAM 521 Diagnostics 

Menu bar – always contains the selections File, on the far left, and Help, on the far right. File menu 
always contains the selection Exit, by which you can dismiss the window; some window 
File menus contain selections special to the window. Help menu provide access to 
information concerning the window. Some windows have additional Menu bar 
selections. 

The Menu bar appears on the top level window for each application. A Menu bar 
appears in the Main Configuration window, for example, but not in the windows you 
access from Main Configuration.
2-2 GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 058R735-V300
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Descriptions in this manual of the individual TEAM 521 applications identify window features 
are specific to the applications, such as selections in the Menu bar and menus, and buttons

Performance Functions

SC 521 DSU Front Panel

The SC 521 Front Panel display window (See Figure 2-1), which you launch from the HPOV Map
(shelf sub-map) window, provides a graphical interface to a selected SC 521 DSU. 

You can launch a Front Panel display by clicking on the slot icon of the unit you intend to work
to select it, and then selecting Front Panel from the Performance menu in the menu bar at th
the window. The application responds with the Front Panel display. 

You can also launch the display by double clicking on the slot icon. If the DSU does not have an 
associated remote (indicated by a box around the slot icon symbol), the application respond
the Front Panel display. 

A DSU that does have an associated remote is identified in the shelf sub-map by a slot icon sym
without a box. When you double click on that icon, the application opens another submap w
displays icons for the SC 521 and its remote with a connecting line to indicate that together 
form a link. Double click on the SC 521 icon in the link submap to reach the Front Panel dis

Name field – identifies the SC 521 the application is currently connected to by displaying the user-
configured shelf name, followed by the DSU slot number, and the user-configured 
device name. 
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The application polls the DSU to keep the states of the LEDs in the Front Panel display curren
time of the most recent poll appears at the bottom of the Front Panel display, to the left of the
button. The time is displayed in white when Auto Poll is enabled, and in yellow when it is disa

The LEDs shown in the display reflect the states of the actual indicators on the physical un

INS In Service normally remains On continually after the DSU 
successfully completes its power-on test

ON Power On

SD Send Data indicates when lit that the DSU is transmitting data, it 
displays a two-headed arrow to indicate transitions

RD Receive Data indicates when lit that the DSU is receiving data from 
the remote DSU, it displays a two-headed arrow to indicate transitions

RS Request To Send indicates when lit that the DTE has data to transmit, 
it displays a two-headed arrow to indicate transitions

CO Carrier On indicates when lit that the DSU is receiving a signal, it 
displays a two-headed arrow to indicate transitions

TMG Provided for future use; no currently supported function

RSP Management Response

ICC Inactive Condition Code is lit when the DSU network interface is 
experiencing an out of sync (OOS) or out of frame (OOF) condition. 

NS No Signal is lit when the DSU is not receiving a signal at its network 
interface

TM Test Mode, is lit red while the DSU performs a diagnostic test; during 
a test employing Self Test a two-headed arrow superimposed on the 
LED indicates that errors have been detected

ALM Alarm, indicates by its color, which matches that of map icons for the 
unit, that the DSU has detected an alarm condition 

ST Self Test is lit while the internal test pattern generator/checker is 
active

LT Local Test is lit while the DSU is in the Local Loopback test condition

RL Remote Loop is lit while the DSU is performing a remote loopback 
test with the remote DSU

DL Digital Loop is lit while the DSU is performing a digital loopback to 
direct data back to the remote DSU

Figure 2-1 SC 521 DSU 
Front Panel

All front panel indicators are lit when the Select button menu item LED Test is set to On. 
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The Select button, at the bottom of the Front Panel display provides access to menus for the
the TEAM 521 application functions. The following table shows the arrangement of the Sele
button menus. It differs somewhat from the arrangement on the Map window menu bar. 

The two Poll selections in the Select button menu determine when the application collects n
information from the DSU to update the Front Panel window: 

• Selecting Demand Poll causes an immediate update of the display. 

• Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable aut
polling. If you select Disable, the Front Panel window displays a static snapshot of the L
states as they were at the last poll, either when the window was launched or a subseque
Demand Poll. 

Each time the Front Panel display is opened, its initial polling rate is determined by the Front
Poll Rate selection of the HPOV map window Misc menu. 

The menu selection Exit dismisses the Front Panel window when you click on it. 

Select Menu Items Menu Selections

Performance

Alarms...

DTE Status...

Line Statistics...

Configuration

Configure...

Maintenance...

Fault

Diagnose...

Demand Poll

Auto Poll (*)

*Displays Off or 
selected poll 

interval

15 seconds

30 seconds

60 seconds

Disable

LED Test (*)

*Displays On or Off On

Off

Exit
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You can launch the TEAM 521 Alarm application from the HPOV Map Performance Menu or f
the front panel menu. The application displays the read-only Alarm Detail window for the sel
DSU (See Figure 2-2). 

The TEAM 521 application gets alarm indications from the DSU in two ways: 

• By receiving traps that the SCM sends automatically in response to alarm conditions at th

• By polling the SCM for changes in alarm conditions at the DSU.

Figure 2-2 Alarm Detail Window

The Alarm Detail window displays alarms grouped into three categories: 

• Major

• Minor 

• Informational
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Major Alarms

EEPROM Checksum – indicates that the non-volatile memory that stores the DSU configura
has become corrupted

Ext. Clock Loss – indicates loss of external clock signal from the DTE 

No Signal – indicates loss of signal at the network interface 

DCD Loss – indicates loss of incoming signal

Streaming – indicates constant RTS condition 

Frame Loss – indicates out of frame condition at the network interface

Line Pairs Reversed – indicates the DDS line was incorrectly installed at the network interfa

TX Failure – indicates failure of the DSU to transmit data 

Minor Alarms

RXD Loss – indicates reception of valid carrier without data (switched carrier operation only

Bipolar Violation – indicates failure of consecutive ones to alternate states in the signal bein
received

Jitter – indicates excessive jitter (phase shift) in the signal being received 

RX Signal Low – indicates low signal level being received at the network interface 

No Loop Current – indicates absence of dc current at the network interface 

Informational Alarms

Front Panel Test – indicates the DSU has been commanded into a test by means of its fron
switches 

DTR Loss – indicates the DSU is not receiving Data Terminal Ready from the DTE 

STC Loopback – indicates the DSU has been commanded into a test by the Telco Serving 
Center (STC) 

TXD Loss – indicates DTE asserted RTS without providing Transmit Data (switched carrier 
operation only) 

DSR Loss – indicates the DSU is not outputting Data Set Ready to the DTE 

Alarm Detail Window Menus

The Alarm Detail window has a File menu and a View menu in its menu bar. 

The File menu contains the selections Demand Poll, Auto Poll, and Exit:

Demand Poll causes an immediate update of the display. 

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable aut
polling. If you select Disable, the Alarm Detail window displays a static snapshot of alarm
conditions as they were at the last poll, either when the window was launched or a subs
Demand Poll. 

Exit dismisses the window. 
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The View menu consists of three selections: Major, Minor, and Informational, each with a ch
box beside it. To remove an alarm category from the window display, click on its check box s
it is unchecked. Clicking a box so that it is checked restores the corresponding category to t
display. 

The time of the most recent poll appears in the bottom left corner of the window. The time is
displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

DTE Status

You can launch the TEAM 521 DTE Status application from the HPOV Map Performance M
or from the front panel menu. The application displays the read-only Status window for the se
DSU (See Figure 2-3). The window displays indicators for the states of the EIA signals at the D
interface. Dark green indicates Off, light green indicates On, and light green with a superimp
two-headed arrow indicates transitions. 

Status Window Menu

The Status window has a File menu in its menu bar with the selections Demand Poll, Auto Po
Exit. 

Selecting Demand Poll causes an immediate update of the display. 

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable auto
polling. If you select Disable, the Status window displays a static snapshot of the EIA indicat
they were at the last poll, either when the window was launched or a subsequent Demand P

The time of the most recent poll appears in the bottom left corner of the window. The time is
displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

Figure 2-3 DTE Status Window
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Line Statistics

You can launch the TEAM 521 Line Statistics application from the HPOV Map Performance M
or from the front panel menu. The application displays DSU transmission information and rece
functions at the network interface during the most recent 15 minutes. You can also save suc
information to a file. The application displays eight columns, described below.

The Minute Interval column simply identifies the time frame for the other seven items in the 
Each row represents one minute. The Status column can display Normal or No Signal. The Tr
Level and Receive Level columns display the strength, in decibels, of the signals being sen
received by the DSU. The Phase Jitter column displays the percentage by which phase shif
received signal exceeds acceptable levels. BPV Count displays the number of instances tha
occurred during the minute when consecutive ones in the signal being received did not alter
states, thus constituting a bipolar violation. The Frame Loss column displays the number of
during the minute that framing bits could not be identified. The Signal Quality column indicate
overall condition of the signal being received during the minute. 

Figure 2-4 Line Statistics Window

Line Statistics Window Menus

The Line Statistics window has a File menu that contains four selections: 

Demand Poll causes an immediate update of the display 

Save Data to File... opens a dialog window in which you can specify the directory path and name of a 
file for storing formatted Line Statistics data

Auto Poll selects how often the display updates while the window is open: options are 1, 2 or 
3 minute intervals, and Disable. When Disable is selected, the window does not 
update automatically while it is open; it can be updated by Demand Poll. 

Exit dismisses the Line Statistics window 
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You can store statistics for later review and record keeping by selecting Save Data to File...
the File menu. The function stores the most recent 15 minutes of data, in a format similar to
appearance of the Line Statistics display screen. 

The menu selection opens a dialog window in which you can specify the directory path and 
name for storing the data. The application automatically appends the file type suffix .521Line
to any file name that does not already have that suffix. 

Configuration Functions

Configure

You can launch the TEAM 521 Configure application from the HPOV Map Configuration Men
from the front panel menu. 

When you launch the application, it initially displays the read-only TEAM 521 Configuration 
window, which has a File menu and a Navigate menu in its menu bar. 

The File menu contains the selections 

• Refresh, which discards all unsaved changes and restores all options in the displayed 
configuration windows to the values they are assigned by the current operating configur

• Save to Unit, which puts the new configuration into use by the DSU 

• Load Template, by which you can recall a stored configuration template that you can then
to the DSU either with or without modifications 

• Save to Template, by which you can store the current configuration on the workstation f
future use as a template 

• Compare to Template, by which you can identify differences between the configuration 
displayed on-screen and a selected template 

• Exit, by which you can dismiss the window. 

The Navigate menu enables you to access the six read/write windows by which you can con
various aspects of DSU operation: 

• System Options

• Network Options

• DTE Options

• Diagnostic Options

• Alarms Reported

• Add Remotes

The TEAM 521 Configure application is fully described in Chapter 3, Configuration. 
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Maintenance

You can launch the TEAM 521 Maintenance application from the HPOV Map Configuration M
or from the front panel menu. 

The application displays one read/write window by which you can control some aspects of D
operation that fall outside the scope of the Configure application. The TEAM 521 Maintenan
application is fully described in Chapter 4, Maintenance. 

Diagnostics
You can launch the TEAM 521 Diagnose application from the HPOV Map Fault Menu or from
Front Panel display Select button menu. 

The application displays one read/write window by which you can control a variety of test func
on the DSU. The TEAM 521 Diagnose application is fully described in Chapter 5, Diagnostics. 

Miscellaneous Functions

Information

You can launch the TEAM 521 Information window from the HPOV Map Misc menu or by dou
clicking on the GDC logo in the Front Panel display. 

Information displays one read-only window that contains the name of the application, softwa
revision level information, and copyright information. The File menu in the menu bar contains
the selection Exit, by which you can dismiss the window. 

Figure 2-5 TEAM 521 Information Window
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Front Panel Poll Rate

You can open the Front Panel Poll Rate window (See Figure 2-5) from the Shelf Map Misc Menu. 
The setting you select in this window determines the initial polling rate for Front Panel displa
each time they are opened. 

The rate selection is a global function. It selects initial polling rate for all front panel displays lin
to a TEAM Core application, regardless of which individual application you access it from. 

There are four selections, each accompanied by a checkbox: 

Slow 

Normal 

Fast 

Demand Poll Only 

The File menu in the menu bar contains two selections: Save to File and Exit. 

To set the desired polling rate, first click on the appropriate checkbox and then select Save 
from the File menu. The precise polling frequency that results from a setting of Slow, Norma
Fast depends on a number of factors. The higher the rate, the more communication and pro
capacity is devoted to maintaining the display. 

The polling rate for an individual front panel display can be changed for the duration of a se
by means of the Auto Poll selection in the Select button menu. Changes you make with that
selection are not retained when the display is closed. 

To dismiss the window, select Exit from the File menu. 

Figure 2-6 Front Panel Poll Rate Window

Note Pad

You can launch the Note Pad application from the shelf submap Misc Menu. The application 
a shell tool on the workstation running the TEAM software. You can use the shell tool to run 
editor, mail tool, or any other software that resides on the workstation. The Note Pad applic
provides this access for keeping records on the system. 
2-12 GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 058R735-V300
Operation Manual Issue 2



ata 

 that 

 ready 

NMP 

lect 

1 
ny 

teps: 

log 

n 

tions 
Chapter 3: Configuration

Introduction

The TEAM 521 Configuration application enables you to set all the options in the SC 521 D
Service Unit through a convenient group of configuration windows. 

If you are adding an SC 521 DSU to a previously installed shelf with a TEAM 521 application
is already up and running, this chapter contains all the information you need to configure it. 

If you are performing initial configuration in a new system, you need to be sure the system is
before you can configure the DSU. Do the following 

• Consult the SpectraComm Manager Card Installation and Operation manual, and make sure 
an IP address is assigned to the SCM. 

• Consult the SpectraComm Manager Card Installation and Operation and TEAM Core 
Operation manuals, and make sure the SCM is correctly configured. 

• Consult HP OpenView documentation, and make sure that OpenView is configured for S
management. 

To Start TEAM 521 Configuration

You can start the TEAM 521 Configuration application by either of two methods: 

• Select a DSU symbol on the shelf submap, then select the Configure option from the 
Configuration menu. 

• Click on the Select button of the Front Panel display, then click on Configuration and se
Configure from the resulting menu. 

Templates

You can store configuration settings as templates on the workstation that runs the TEAM 52
application. A template stores a configuration for the DSU options, and you can store as ma
templates as you need. 

To load configuration settings from a template into the DSU you must perform the following s

1. Select Load Template from the File menu and select the template from the resulting dia
window. The application retrieves the configuration settings of the selected template. 

2. Select Save to Unit from the File menu. The application makes the template configuratio
settings the current operating configuration for the DSU. 

Configuration Procedure

The following steps describe how to use the configuration application, and illustrate the func
of the Main Configuration window menus. 
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1. Access the Main Configuration window, either from the submap or from the Front Panel
display. The application reads the current Main configuration from the DSU when you op
the Main window. 

You can select to base your configuration changes on either the current configuration or a
configuration template. In either case, the DSU continues to operate using its unchanged 
configuration. 

The Refresh selection on the Main window File menu causes the application to read the curre
configuration from the DSU. All changes to all configuration windows that have not previo
been saved to a profile or a template are lost when you select Refresh. 

2. To edit the current configuration of the DSU, proceed directly to the Navigate menu as 
described below. 

To edit a template, select Load Template from the File menu and select a template from th
resulting list. 

3. Click on the Navigate button to display a menu of the configuration windows, and select t
one in which you intend to make changes. 

4. Make changes as needed in the configuration window. When you click on the input field f
option, a window opens to display all the values the field can be set to. Click the mouse o
value you select. When you change the value or setting of an option, the application dis
the option name and the new value in white, rather than black, type. They remain white 
you either save the changes to the DSU or a template by means of the Main window File 
or restore the option to its last stored value or setting. 

You can discard changes to a configuration window and return all its fields to their stored v
in two ways:

• Click on the Reset button to discard changes while keeping the window open

• Click on the Cancel button to discard changes and close the window. 

You can close a configuration window without losing changes by clicking on either the OK 
button or the pushpin icon, which is located in the upper left corner of the window.

You can keep multiple configuration windows open on-screen and move between them 
clicking the mouse on the one in which you intend to operate. The Main Configuration win
remains on-screen throughout the configuration process. 

5. When you have accessed all the configuration windows that you need to and made all o
changes, click on the File menu button of the Main Configuration window. From that menu
you can select Save to Unit to save the new configuration in the DSU, or select Save to 
Template to save it as a template in the workstation. 

6. When you select Save to Unit, the changed configuration for the DSU becomes the curr
configuration. 

7. When you select Save to Template, a window appears containing a list of existing templ
and a field for entering a new template name. You can select an existing template to be 
overwritten with the new configuration, or enter a name to create a new template. A stor
template is available to be loaded by the application and then saved, with or without furt
modification, to any SC 521 DSU. 
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Configuration Option Values

When you click the mouse on the entry field for a configuration item, a window opens conta
all the values that are permitted for that configuration item. Hold down the mouse button un
highlight is on the value you intend to configure, then release the button. The newly selected
appears in the entry field for the configuration item. 

Main Configuration Window

The Main Configuration window has two pull down menus, File and Navigate, that are the m
by which you carry out the actual process of configuring the DSU. From the Navigate menu you 
select the individual configuration windows in which you make changes. The File menu commands 
the storage and retrieval of configuration settings. The functions available in the Navigate an
menus can also be invoked by clicking selections in the on-screen tool bar.  The contents of t
menus appear below. 

The Main Configuration window title bar displays the application name, TEAM 521 Configurat
The main body of the window contains items arranged under the headings Operation, Softwa
Hardware that identify the selected unit and provide information about its operations. 

The button below the main tool bar, marked with two triangles, toggles display of the window
information panel. Clicking on that button when the full Configuration window is displayed ca
the information panel to disappear so that the window consists of just the title, menu, and too
Clicking the button while the window is in its reduced condition restores the full Configuratio
window. 

Menu Buttons Menu Selections
Further 

Selections

File

Refresh

Save to Unit

Load Template dialog window

Save to Template dialog window

Compare to Template dialog window

Exit

Navigate

System Options... 

Network Options...

DTE Options... 

Diagnostic Options...

Alarms Reported... 

All Above Screens... 

Add Remotes...
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Main Configuration Window Display

The Main Configuration window displays the following read-only items: 

The TEAM 521 application relies on the SCM and SC 521 DSU to indicate when a configura
problem has caused an SNMP set error. 

Figure 3-1 Main Configuration Window

Name: name assigned to the selected DSU 

Operation

Slot State: Active or Inactive

Operational Status: Online

Software

Serial Number: serial number of the selected unit

Active Firmware Rev:  revision level of the operating code the selected unit is currently using

Standby Firmware Rev: revision level of operating code stored by the selected unit but not currently in use 

Boot Code Rev: revision level of the boot-up operating code in the selected unit 

MIB Version: revision level of the Management Information Base files in the selected unit 

Hardware

DTE Interface Type V.35 or RS232 
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System Options
The System Options configuration window contains three configuration options. 

Figure 3-2 System Options Configuration Window

Alarm Scan – permits you to enable or inhibit (disable) the alarm scan. 

Options:

• Enable – DSU reports alarms to the SCM

• Disable – DSU does not report alarms to the SCM

Front Panel Switches – permits you to disable the switches on the front panel of the DSU as
protection against any inadvertent interruption of its operation. 

Options:

• Enable – DSU front panel switches are operational 

• Disable – DSU front panel switches are disabled 

Response Timeout – selects the length of time the SCM waits for a response from the unit be
it declares a No Response condition. 

Options:

• 2, 4, 6, 8 seconds
058R735-V300 GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 3-5
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Network Options

The Network Options configuration window contains two groups of options grouped under th
headings Network Parameters and Circuit Parameters. 

Figure 3-3 Network Options Configuration Window

Network Parameters

Circuit Type  – selects the type of circuit over which the DSU communicates with its remote un

Options:

• Pt to Pt - Clear Channel – specifies a point-to-point 64 kbps circuit; when this is select
the Data Rate option is forced to this value and cannot be changed 

• Pt to Pt - DDS-I – specifies a point-to-point DDS-I circuit at any Data Rate up to 56 kb
(Default) 

• Pt to Pt - DDS-SC – specifies a point-to-point DDS-SC circuit at any Data Rate up to
kbps 
3-6 GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 058R735-V300
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• Multipoint - DDS-I – specifies a multi-point DDS-I circuit at any Data Rate up to 56 kb

• Multipoint - DDS-SC – specifies a multi-point DDS-SC circuit at any Data Rate up to
kbps 

Carrier  – selects the combination of transmit and receive carrier modes (constant/switched)
used by the DSU 

Options:

• Tx Constant, Rx Constant – for use on a point-to-point circuit (Default) 

• Tx Constant, Rx Switched – for use when the DSU is the master unit on a multi-point
circuit 

• Tx Switched, Rx Constant – for use when the DSU is a remote unit on a multi-point circ

• Tx Switched, Rx Switched – for use when required by specialized applications

Data Rate – selects the data rate and mode (synchronous/asynchronous) to be used by the

Options:

• 2.4 Kbps - Async 

• 2.4 Kbps - Sync 

• 4.8 Kbps - Async 

• 4.8 Kbps - Sync 

• 9.6 Kbps - Async 

• 9.6 Kbps - Sync 

• 19.2 Kbps - Async 

• 19.2 Kbps - Sync 

• 56 Kbps - Sync (Default) 

• 64 Kbps - Sync – this value is displayed when the Data Rate option is forced by selec
of Pt to Pt - Clear Channel in the Circuit Type option 

Note The setting of this option affects the reported/not reported states of the RxD Loss and TxD Loss alar
the Alarms Reported configuration screen. When a constant carrier is selected, the corresponding d
loss alarm in that screen is forced to not reported (unchecked) and grayed out. If the alarm had 
previously been selected to be reported, the change does not go into effect until the configuration is 
to the unit. 
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Circuit Parameters

Tx Clock Source – selects the source of transmit timing for the DSU 

Options:

• Receive – selects transmit timing based on receive data timing (Default) 

• Internal – selects transmit timing provided by the DSU internal clock 

• External – selects transmit timing provided by the DTE; the Buffer Clock option is forc
to External and cannot be changed when this is selected 

Buffer Clock – selects the source of timing for the buffer between the DSU and its DTE 

Options:

• Internal – selects timing provided by the selected Tx Clock Source (Default) 

• External – selects timing provided by the DTE; when External is selected for Tx Clo
Source this selection is forced and cannot be changed 

Zero Encoding – selects Zero Encoding, required for 56 kbps DDS-SC applications in which
primary and secondary channels are not permitted to transmit all spaces (zeros) at the sam

Options:

• Enable – DSU prevents the all space condition at the expense of reduced seconda
channel bandwidth (Default) 

• Disable – DSU does not prevent the all space condition 

Remote Unit Type – specifies the type of remote DSU with which the DSU is to be used. Thi
option is only available to be set when the Circuit Type option in the Network Options configur
window is selected as Multipoint and no remote units have yet been added by the Add Rem
application. In all other circumstances the function of this option is overridden and the option
grayed out.

Options:

• NMS 520 – when the remote DSUs are specified to be the NMS 520 unit the option
Sentry Timer, Rmt Rsp Interval, and Alarm Hysteresis are available to be configured
selection enables the NMS 520 DSUs to be added as remotes 

• NMS 510 – when the remote DSUs are specified to be NMS 510 units the options S
Timer, Rmt Rsp Interval, and Alarm Hysteresis are grayed out (Default) 

Sentry Timer – selects the minimum time interval permitted between alarm reports from a re
NMS 520 DSU operating in a DDS1 or clear channel point-to-point link 

Options:

• Disable 

• 1 Minute to 5 Minutes – in one minute increments

• 10 Minutes 

• 15 Minutes to 60 Minutes – in 15 minute increments (Default 60) 

• 90 Minutes

• 120 Minutes 
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Remote Rsp Interval – selects the minimum time interval permitted between alarm reports fro
remote NMS 520 DSU in a DDS1 multi-point link 

Options:

• Disable 

• 10 Seconds to 120 Seconds – in ten second increments (Default 10) 

Circuit Assurance – when this option is enabled the DSU clamps Clear To Send when it det
any of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or 
Inactive Channel Code 

Options:

• Disable (Default) 

• Enable 

System Status – when this option is enabled the DSU clamps Data Set Ready when it detect
of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or Inact
Channel Code 

Options:

• Disable (Default) 

• Enable 

Note All remote units on a multi-point link must be set for the same Remote Response Interval value.
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DTE Options

The DTE Options configuration window contains three groups of options under the heading
Interface, Control Parameters, and Async Parameters. 

Figure 3-4 DTE Interface Configuration Window

Interface

Interface Type – read-only field displays the DTE port type 

Options:

• RS232 – EIA/TIA-232-E interface 

• V.35 – ITU-T V.35 interface 

Interface Adapter – read-only field displays whether or not the DSU has a Data Rate Adapte
(DRA) card installed 

Options:

• None 

• Installed 
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Control Parameters

AAS – selects whether or not the DSU provides Automatic Anti-Streaming protection, and the
limit it enforces when the feature is enabled 

Options: 

• Disable (Default) 

• 5 Seconds

• 10 Seconds

• 30 Seconds

• 45 Seconds

Constant DSR – selects the DSU to output either a constant or a switched Data Set Ready s
to its DTE. 

Options: 

• Disable – switched DSR signal controlled by DTR 

• Enable – constant DSR signal (Default) 

CTS Delay – selects the delay (if any) between the DSU receiving Request To Send from the
and returning Clear To Send to the DTE. 

Options: 

• CTS ON – no delay; grayed out when multi-point link is selected Circuit Type (Defau

• Fixed 3 Char – equivalent to three character times 

• 0 msec 

• 30 msec 

• 60 msec 

• 90 msec 

HDLC Invert – selects whether or not the DSU uses inverted channel data from the DTE. D
inversion is used primarily with DDS-SC 56 kbps circuits, to enhance data quality in a networ
does not provide B8ZS coding. 

Warning You must consider the following factors when you change the setting of this option: 

When changing the setting of this option, set only this option and save the change to the uni
not combine it with any other configuration changes. 

The option must be set the same at both ends of the link. 

You must make changes at the remote DSU first, before you change the option setting at the

Changing the option at the remote results in an “SNMP ‘Set’ Request Failed” error message a
causes loss of communication between the remote and master units. Click on OK in the er
message box to dismiss the message, then proceed to change the option setting at the ma
Communication resumes when the option change goes into effect at the master unit.
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Options: 

• Disable – normal data (Default) 

• Enable – inverted data

Async Parameters

The Async Parameters options are grayed out when a synchronous Data Rate is selected in
Network Interface configuration. 

Character Size – selects the number of bits per asynchronous character, including start and
bits 

• Options: 

• 11 Bits (Default) 

• 10 Bits 

• 9 Bits 

• 8 Bits 

Over Speed – selects the percentage above its configured normal operating rate at which the
can accommodate receive data. It performs the over speed compensation by shaving stop b

Options: 

• 1% (Default) 

• 2.3%

Suppression – determines what actions the DSU takes concerning transmit and receive End o
(EOT) 

Options: 

• Disable – the DSU does not insert EOT at the end of transmissions, and does not d
it from the end of received signals (Default) 

• Rx EOT – the DSU deletes EOT from the end of received signals; it does not insert 
at the end of transmissions 

• Tx EOT – the DSU inserts EOT at the end of transmissions; it does not delete it from
end of received signals 

• Rx + Tx EOT – the DSU inserts EOT at the end of transmissions, and deletes it from
end of received signals 

Rate Adaption – specifies the DTE interface operating rate when it is below that of the DDS
circuit; valid only when Data Rate in the Network Options screen is set to 2.4 Kbps - Async

Options: 

• Disable (Default) 

• 600 

• 1200 

• 1800 to 2400 
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Diagnostic Options

The Diagnostic Options configuration window contains two groups of options under the hea
DTE Equipment and Network Parameters. 

Figure 3-5 Diagnostic Options Configuration Window

DTE Equipment

Line Loopback Control – selects whether or not the DTE can command the DSU into a Line
Loopback (local) test by means of a signal at the interface port on EIA pin 18 

Options:

• Enable 

• Disable (Default) 

Remote Loopback Control – selects whether or not the DTE can command the DSU into a Rem
Loopback test by means of a signal at the interface port on EIA pin 21 

Options:

• Enable 

• Disable (Default) 

Data Set Ready – selects how the DSU controls the DSR output to the DTE during test mode
058R735-V300 GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 3-13
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Options:

• Off During Test 

• Normal – DSR operates in the same way that it is optioned to function during data m
operations (Default) 

Network Parameters

Line Loopback Test Points – selects whether a Line Loopback command causes the DSU on
loop transmit data back to the DTE, or also to loop receive data back to the network 

Options: 

• DTE Only – Line Loopback command causes DSU to loop data back to DTE only 
(Default) 

• Network & DTE – Line Loopback command causes DSU to loop data in both direct

Telco Latching Loopback Response – selects whether or not the DSU accepts the latching-ty
DSU Loopback command code from a Telco Serving Test Center (STC). The latching-type 
command code places the unit into the test condition, which continues until a second comman
is sent by the STC. 

The DSU always accepts the non-latching DSU loopback command code, which places the 
the test condition only as long as the code continues to be received. 

Options: 

• Enable – DSU accepts latching-type DSU Loopback command code (Default) 

• Disable – DSU does not accept latching-type DSU Loopback command code

Customer RDL Response – selects whether or not the DSU accepts a remote loopback comm
from its remote DSU 

Options: 

• Enable – the DSU accepts the remote loopback command selected by the RDL Init
Sequence option (Default) 

• Disable – the DSU does not accepts a remote loopback command 

RDL Auto Timeout  – selects whether or not the DSU ends remote digital loop automatically b
on a timeout 

Options: 

• 10 Minutes – DSU terminates remote digital loop after ten minutes without need fo
further operator action. You can end the test manually before the timeout. 

• Disable – remote digital loop continues until terminated by operator action (Defaul

RDL Initiation Sequence – selects the remote loopback command the DSU accepts from its
remote DSU 
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Options: 

• V.54 (Default) 

• PN 127 

• GDC

Alarms Reported
The Alarms Reported configuration window (Figure 3-6) lets you configure which alarm 
conditions are to be reported for the DSU and which are not.

Figure 3-6 Alarms Reported Configuration Window

Buttons and Option Selection

Each of the alarm options in the Alarms Reported configuration window has a small selection
located to its left. You can select or de-select individual alarm options by simply clicking the m
button on the appropriate selection fields. When an option is selected for its alarm to be rep
its selection field is highlighted. The selection fields next to alarm options that are not to be rep
are not highlighted. 

The Alarms Reported configuration window has two buttons positioned above the option fie
Report All and Report None:

• Click on Report All to highlight all the alarm option selection fields. 

• Click on Report None to remove the highlight from all the alarm option selection fields. 
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After clicking Report All or Report None you can then change the state of individual fields as
needed. 

Alarm Options – Network

Each Network alarm, when designated to be reported, requires you to specify a threshold a
which it is evaluated. Default for all is Masked; listed default threshold value takes effect whe
alarm is set to Reported. 

Alarm Interval  - determines the time span for threshold evaluation. 

Options:

• 1 min, 5 min, 10 min, 15 min (Default 15) 

Bipolar Violation  - lets you select whether or not Bipolar Violation (BPV) alarms are to be 
reported. A network BPV occurs when the signal the unit receives at its network interface do
alternate between signal levels as required for Alternate Mark Inversion (AMI) or Bipolar wit
Zero Substitution (B8ZS) data encoding. The alarm occurs when the number of Bipolar Viola
in the received signal during one Alarm Interval exceeds the selected threshold. 

Options:

• 1, 2, 5, 10, 20, 40, 60, 80, 99 (Default 10) 

Jitter  - lets you select whether or not Jitter alarms are to be reported. The alarm occurs whe
percent of jitter in the received signal remains above the selected threshold for at least one 
Interval. 

Options:

• 1%, 2%, 5%, 10%, 20%, 40%, 60%, 80%, 99% (Default 10%) 

Frame Loss - lets you select whether or not Frame Loss alarms are to be reported. The alarm 
when the number of lost frames in the received signal during one Alarm Interval exceeds th
selected threshold. 

Options:

• 1, 2, 5, 10, 20, 40, 60, 80, 99 (Default 10) 

Receive Signal Low - lets you select whether or not Receive Signal Low alarms are to be repo
The alarm occurs when the strength of the received signal remains below the selected thresh
at least one Alarm Interval. 

Options:

• -50 dB, -40 dB, -30 dB, -25 dB, -20 dB, -15 dB, -10 dB, -5 dB, 0 dB, 6 dB (Default -30) 

Alarm Options – DTE

• Default for all is Masked. 

• Data Carrier Detect Loss – indicates loss of DCD 

• Data Set Ready Loss – indicates loss of DSR 

• Data Terminal Ready Loss – indicates loss of DTR signal from DTE

• Receive Data Loss – indicates no receive data from the remote DSU 
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• Transmit Data Loss – indicates no transmit data from the DTE 

• External Clock Loss – indicates loss of external clock signal from DTE

• Streaming – indicates constant RTS condition 

Alarm Options – Unit

Default for all is Masked. 

No Signal – indicates loss of signal at network interface

Line Pairs Reversed – indicates line pairs reversed at network interface 

STC Loopback – indicates the DSU has been commanded into a test mode by the Telco Servin
Center (STC) or by a Remote Digital Loop command from its remote DSU 

Front Panel Test – indicates the DSU has been commanded into a test mode by means of its
panel switches 

No Loop Current – indicates no current at network interface 

EEPROM Checksum – indicates detection of an error in the Configuration Checksum 

Transmitter Failure – indicates that the DSU has failed to transmit data 

Associated Remote
There are two Add Remote configuration windows, one for a single remote in a point-to-poin
circuit and one for the multiple remotes of a multi-point circuit. The selection made for the Ci
Type option in the Network Options configuration window determines which Add Remotes 
window is displayed when you select Add Remotes from the Navigate menu in the Main 
Configuration window. 

Note The Receive Data Loss and Transmit Data Loss alarms are dependent on the configuration of the C
option in the Network Options screen. That option selects combinations of switched and constant re
and transmit carriers. When a constant carrier is selected, the corresponding data loss alarm in this
screen is forced to not reported (unchecked) and grayed out. If the alarm had previously been selec
be reported, the change does not go into effect until the configuration is saved to the unit.

Note If you have an Add Remote window open when you change the setting of the Circuit Type
option, the application automatically closes the Add Remote window. 
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Add Remote, Point-to-Point Circuit

The window is shown in Figure 3-7 as it appears when the DSU is configured for use in a point
point circuit. 

Figure 3-7 Add Remote Window (Point-to-Point Circuit)

Perform the following procedure to add the remote DSU in a point-to-point circuit: 

1. Select Add Remote from Main Configuration window Navigate menu. The Add Remote 
window appears. The Serial Number field is blank when the window first appears. 

2. Click on the Wake Up Remote button. This commands the TEAM 521 application to crea
software structures that it requires in order to command and monitor the remote DSU in
conjunction with the DSU. The application indicates success by displaying the serial num
of the associated remote DSU. 

3. Click OK to dismiss the window. 
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Add Remote, Multi-Point Circuit

The window is shown in Figure 3-8 as it appears when the DSU is configured for use in a mul
point circuit. The window is divided into two panels labeled Add Remote and Current Remotes
Add Remote panel contains the two fields and the button by which you perform the process
adding remote units. The Current Remotes panel is a display of units currently on the circui
identified by their drop numbers. 

In this window the Serial Number field is an entry field for you to specify the serial number o
unit you are adding, rather than a display field. One of two messages appears above the Se
Number field, either “Enter NMS510 type serial numbers only,” or “Enter NMS520 type seria
numbers only.” The setting of the Remote Unit Type option in the Network Options window 
determines which of the two messages is displayed. If you change the setting of that option
cannot add a remote until the change is saved to the unit.

Figure 3-8 Add Remote Window (Multi-Point Circuit)

Perform the following procedure to add a remote DSU in a multi-point circuit: 

1. Select Add Remote from Main Configuration window Navigate menu. The Add Remote 
window appears. The Serial Number field is blank when the window first appears. 

2. Enter the 16-digit serial number of the remote you are adding. 

3. Click on the Drop entry field and from the resulting menu select the drop number you ar
assigning to unit. 

4. Click on the Add Remote button. This commands the TEAM 521 application to create th
software structures that it requires in order to command and monitor the remote DSU in
conjunction with the master DSU. The application indicates success by adding an entry f
new drop number to the list displayed under Current Remotes. 

5. Click OK to dismiss the window. 
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Chapter 4: Maintenance

Introduction
The TEAM 521 Maintenance application provides a group of functions for controlling the oper
of an SC 521 Data Service Unit. 

To Start TEAM 521 Maintenance 
You can start the TEAM 521 Maintenance application by either of two methods: 

• Select an SC 521 DSU symbol on the shelf submap in OpenView, then select the Mainte
option from the Configuration menu. 

• Click on the Select button of the Front Panel display, then click on Configuration and se
Maintenance from the resulting menu. 

The window title bar displays the application name, TEAM 521 Maintenance. The Name fiel
displays the shelf and slot identification for the DSU. See Figure 4-1.

Figure 4-1 Maintenance Window
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Maintenance Window Buttons
The Maintenance window provides the following three buttons. 

Front Panel – permits you to enable or disable the hardware switches on the front panel of th
521 DSU. The label on the button appears as either Inhibit Front Panel or Enable Front Pan
it toggles between the two displays each time you click on the button. The button displays In
Front Panel when the switches are enabled, and it displays Enable Front Panel when they a
disabled. 

Reset to Factory Defaults – causes all options in the DSU to return to their factory default settin
When you click on this button the application displays a warning “Resetting to factory defaults
disrupt communications to the unit. Do you want to continue?” Click on the OK button in the
warning window to complete the reset, or click on the Cancel button to cancel the reset. 

Perform Soft Reset – causes the DSU to perform a reset and resume operation using its cur
configuration. When you click on this button the application displays a warning “Performing a
reset will disrupt communications to the unit. Do you want to continue?” Click on the OK butto
the warning window to complete the reset, or click on the Cancel button to cancel the reset.
4-2 GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 058R735-V300
Operation Manual Issue 2



521 
 lines 

 test 

ploys 

Exit 
istory, 

you can 
o 

Pattern 
 pattern. 
Chapter 5: Diagnostics

Introduction

The TEAM 521 Diagnostics application enables you to perform a variety of tests on the SC 
DSU. Tests can involve just the local DSU, or the local and remote DSUs and the telephone
that connect them. 

Diagnostics Window

Beneath the menu bar and the Name field the Diagnostics window (See Figure 5-1) is divided into 
three areas:

• Selection panel – contains buttons and check boxes for selecting, starting, and stopping
functions

• Graphic panel – depicts the path followed by test data during the current test 

• Time and results panel – contains an input field for specifying the duration of a test that em
the DSU test pattern generator; displays Time Remaining and Test Results 

The Diagnostics window menu bar contains File and Navigate. The File menu has only the 
selection by which you dismiss the window. The Navigate menu also has a single selection: H
by which you can access a display of test results (see Figure 5-6) accumulated during the current 
diagnostic session. 

Tests

The Diagnostics window selection panel lists three Tests to choose from, and three Patterns 
select for those tests that employ the DSU test pattern generator. The panel also includes tw
buttons, Start Test and Stop Test. 

The following Tests are available: 

• Line Loop (can be performed with or without test pattern) 

• Remote Loop (can be performed with or without test pattern) 

• Data Loop

The three Patterns are: 

• 511 

• 2047 

• 15 bit 

Each Test and Pattern is accompanied by a check box on which you can click to select it. The 
check boxes are grayed out when the selected Test cannot be combined with an internal test
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Diagnostic Test Procedure

Perform the following steps to select and carry out a test procedure on the selected DSU. 

1. Click on the check box next to the selected test: Line Loop, Remote Loop, or Data Loop

2. If you have selected Line Loop or Remote Loop you can perform the test either with an 
internally generated test pattern, or with externally generated and checked data. Under 
Pattern heading, click on 511, 2047, 15 Bit, or None (for external data). No Pattern selec
required for Data Loop. 

3. If you are using an internally generated test pattern select, in the Test Time field, how lon
test is to run before ending automatically. 

4. Click on the Start Test button. While the test runs, the graphic panel illustrates the data 
employed by the test. If you are using an internally generated test pattern, the Time Rem
field counts down from 100 to 0 percent. 

5. During a test that employs an internally generated test pattern the Test Results field disp
Running: followed by the number of errors detected; it displays In Loop when external da
in use. 

6. If you are using an internally generated test pattern, the test ends automatically at the e
the specified Test Time. For any other test, click on the Stop Test button to end the proc
The Stop Test button can also stop a test with test pattern prior to the Test Time limit tha
would end it automatically. 

Figure 5-1 Diagnostics Window
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Diagnostics Table
The table below briefly describes the available tests. Each test is described more fully and illu
by a diagram under the headings that follow. 

Line Loop
The Line Loop test (See Figure 5-2) lets you isolate problems in the operation of the DSU and 
DTE interface. 

Figure 5-2 Line Loop Test

Test Description

Line Loop 
(without 
Pattern)

DSU initiates a local loopback, through which the DTE or external test 
equipment connected to the DTE interface can direct a test pattern. 
Must be ended by means of the Stop Test button. 

Line Loop 
(with Pattern)

DSU initiates a local loopback and activates its own test pattern 
generator/checker.

Remote Loop 
(without 
Pattern)

Local DSU commands the remote DSU to initiate a digital loopback. A 
test pattern from the local DTE or from external test equipment 
connected to the local DTE interface can then be directed through the 
resulting test path. Must be ended by means of the Stop Test button. 

Remote Loop 
(with Pattern)

Local DSU commands the remote DSU into digital loopback and 
activates its own test pattern generator/checker.

Data Loop Local DSU loops data it receives from the remote DSU back to the 
remote DSU. Must be ended by means of the Stop Test button. 
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Line Loop with Test Pattern
Because the pattern generator and checker are internal to the DSU, the DTE interface is not
the Line Loop test path when you select a test pattern. The use of an internally generated test
enables the display of detected errors in the Test Results field. 

Figure 5-3 Line Loop with Self-Test

Remote Loop
In this test the DSU sends a remote loop command to the remote DSU. The selection of a V
PN 127 remote loop command is made in the Diagnostic Options configuration window. In 
response the remote DSU couples its receive data to its transmitter input for transmission b
the DSU at the local end (See Figure 5-4).

Figure 5-4 Remote Loop

Note The two remote tests, Remote Loop and Remote Loop with Test Pattern, are only available in a poi
point network, and they are not compatible with a remote GDC 520 DSU or GDC 510 DSU. 

You can achieve the same functionality with either of those units by directly commanding the remote
into a loopback.
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Remote Loop with Test Pattern
In this test the local DSU sends a Remote Loop command to the remote DSU, then generate
pattern that it transmits over the network to the remote DSU. The remote DSU loops the rec
pattern to its transmitter and sends it back to the DSU for analysis (See Figure 5-5). This test checks 
the DSU, the remote DSU, and the link. 

The use of an internally generated test pattern enables the display of detected errors in the 
Results field. 

Figure 5-5 Remote Loop with Test Pattern

Data Loop
In Data Loopback (See Figure 5-6) local receive data is coupled to the transmitter input so that 
remote unit can perform a loopback test without commanding Remote Loopback. The remote
site is responsible for test pattern generation and checking in this test. 

.

Figure 5-6 Data Loop
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Diagnostics History
You can view a record of tests performed during the current diagnostic session by selecting H
from the Navigate menu in the Diagnostics window. The record appears as a listing in the 
Diagnostics History window (see Figure 5-7). 

Figure 5-7 Diagnostics History

The Diagnostics History displays information in five columns:

• Start Time – date and time test began 

• Test – name of the test 

• Pattern – test pattern used for the test; N/A when internally generated pattern is not use

• Test Blocks – number of data blocks used in the test, applies only to tests with test patte

• Test Results – “Idle: n Errors” for a completed test with test pattern; “Not in loop [STOPPED
for a completed loop test without test pattern; “TEST STOPPED” for any test with test pa
that was ended by the Stop Test button 

To close the Diagnostics History window, click on either the OK button or the pushpin icon in
upper left corner of the window. During an on-going diagnostic session you can close and re
the Diagnostics History window without loss of display data. 

The application clears the Diagnostics History when you exit from the Diagnostics window. 
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Chapter 6: NMS 520

Overview

The SC 521 Data Service Unit (DSU) can operate in conjunction with an NMS 520 DSU loca
a remote site. The TEAM 521 software supports a full range of functions for the remote NMS
DSU, as it does for the SC 521 DSU. This chapter describes the NMS 520 functionality of th
software and provides instructions for its use. 

Access to the NMS 520 Functions

Access to the NMS 520 functions takes place through the icon for the SC 521 DSU that is lin
the NMS 520 DSU that you intend to work with. 

1. 1.Display the shelf map. Any DSU that does not have an associated remote is identified by 
box around its icon symbol. Each DSU that has an associated remote is identified by an
symbol without a box. 

2. 2.Double click on the icon symbol of the DSU that is linked to the DSU you intend to wo
with. The application responds by opening a submap that displays icons for the two DSU
a connecting line to indicate that together they form a link. 

3. 3.From this submap you can either click once on the DSU icon to select it and then acce
functions through the menu bar of the submap window, or double click on the DSU icon 
open the NMS 520 Front Panel display window. From the Front Panel display you can a
NMS 520 functions through Select button menus. 

Master/Remote Communications

Management communications take place on the secondary channel when the link between 
master SpectraComm 521 DSU and the remote NMS 520 DSU is configured to be DDS II w
secondary channel. 

When the link is configured for DDS I or for clear channel the management communications
occupy the same channel that carries user data. When that is the case, each management 
communication has the effect of briefly interrupting or causing errors in the user data. Error 
correcting protocols and requests for retransmission protect user data against corruption, bu
effect does slightly reduce throughput. 

Note Reduction in throughput caused by management communications is most noticeable when the Fron
Panel display or the Alarm Detail window is open with Auto Poll enabled. The faster the scan rate se
selected for Auto Poll, the greater the effect on user data.
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Submap Window Menu Bar Access

The table on the following page illustrates how the NMS 520 functions of the TEAM 521 
application are arranged on the menu bar at the top of the HPOV link submap window. The
shows only the menu selections for the NMS 520 functions. The submap window menus inc
other selections as well because the window is accessible to other applications. 

You must click on the DSU icon to select it before you open the menu you intend to use. 

The Performance menu Front Panel selection opens the Front Panel display window, which
provides access to menus through its Select button. All the menu selections shown above ap
the Select button menus except Front Panel in the Performance menu and the two items in th
menu. 

NMS 520 DSU Front Panel

The NMS 520 Front Panel display window (See Figures 6-1 and 6-2) provides a graphical interface
to a remote NMS 520 DSU. You can launch a Front Panel from the link submap, described 
under the heading Access to the NMS 520 Functions, in either of two ways: 

• select the NMS 520 icon in the submap window, then select Front Panel from the Perform
menu for the window

• double click the mouse on the NMS 520 icon. 

Menu Bar Menu Selections

Performance

Front Panel...

Alarms...

DTE Status...

Line Statistics...

Configuration

Configure...

Maintenance...

Fault

Diagnose...

Misc

Front Panel Poll Rate...

Note Pad 
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The application responds by displaying a window that depicts the front panel of the selected
520 DSU unit. There are two NMS 520 DSU Front Panel displays, one for the model with 
Intelligent Front Panel (IFP) and one for the model without IFP. 

Figure 6-1 NMS 520 IFP DSU Front Panel

Figure 6-2 NMS 520 Non-IFP DSU Front Panel

The LEDs shown in the display reflect the states of the actual indicators on the physical uni

• NS – No Signal indicates when lit that there is no signal at the network interface of
remote DSU 

• SD – Send Data indicates when lit that the DSU is transmitting data 

• RD – Receive Data indicates when lit that the DSU is receiving data 

• RS – Request to Send indicates when lit that the DTE has data to transmit 

• CS – Clear to Send indicates when lit that the DSU is prepared to transmit data 

• CO – Carrier On indicates when lit that the DSU is receiving a carrier signal at its net
interface 

• TR – Terminal Ready indicates when lit that the DTE is powered on

• NORM – DSU mode indication, when lit indicates DSU in normal mode; when off 
indicates DSU in diagnostic mode 

• TEST/OK – indicates when lit that the DSU is receiving valid test data 

• DBU – not a valid indicator in the TEAM application environment 

• NETCON CO – not a valid indicator in the TEAM application environment 

• NETCON DATA – not a valid indicator in the TEAM application environment 

• NETCON RESP – not a valid indicator in the TEAM application environment 

• NETCON TEST – not a valid indicator in the TEAM application environment 
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The application polls the DSU to keep the states of the LEDs in the Front Panel display curren
time of the most recent poll appears in the bottom left corner of the Front Panel display. The
is displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

The Select button on the Front Panel displays provides access to menus for the rest of the N
functions of the TEAM 521 application. The following table shows the arrangement of the S
button menus. It differs somewhat from the arrangement on the submap window menu bar.

The two Poll selections in the Select button menu determine when the application collects n
information from the DSU to update the Front Panel window:

• Selecting Demand Poll causes an immediate update of the display. 

• Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable aut
polling. If you select Disable, the Front Panel window displays a static snapshot of the L
states as they were at the last poll, either when the window was launched or a subseque
Demand Poll. 

Each time the Front Panel display is opened, its initial polling rate is determined by the Front
Poll Rate selection of the HPOV map window Misc menu. 

The menu selection Exit dismisses the Front Panel window when you click on it. 

Select Menu Items Selections

Performance

Alarms...

DTE Status...

Line Statistics...

Configuration

Configure...

Maintenance...

Fault

Diagnose...

Demand Poll

Auto Poll

15 seconds

30 seconds

60 seconds

Disable

Exit
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Alarms

You can launch the NMS 520 Alarm Detail application from the submap Performance Menu
from the front panel menu. The application displays the read-only Alarm Detail window for th
selected DSU (See Figure 6-3).

The TEAM 521 application polls the DSU for changes in alarm conditions.

Figure 6-3 Alarm Detail Window

The Alarm Detail window displays alarms grouped into three categories: 

• Major

• Minor 

• Informational
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Major Alarms

• EEPROM Checksum – indicates that the non-volatile memory that stores the DSU
configuration has become corrupted

• No Signal – indicates no signal at the DSU network interface 

• Line Pairs Reversed – indicates line pairs reversed at network interface 

• Streaming – indicates constant RTS condition at the DTE interface

• DTP Loss – indicates loss of Data Terminal Power 

• DCD Loss – indicates loss of Data Carrier Detect 

• DCD Shorted – indicates Data Carrier Detect lead shorted to ground 

• CTS Shorted – indicates Clear To Send lead shorted to ground 

• RXD Shorted – indicates Receive Data lead shorted to ground 

• RXC Shorted – indicates Receive Timing lead shorted to ground 

• TXC Shorted – indicates Transmit Timing lead shorted to ground 

• Frame Loss – indicates loss of framing 

• No DSU Response – indicates the remote DSU does not respond to polling by the m
unit (valid only in DDS I operation) 

• No DTE Polling – indicates the DTE connected to the remote DSU does not respo
polling by the master unit (valid only in DDS I operation) 

Minor Alarms

• No Loop Current – indicates no current at network interface

• TM Shorted – indicates Test Mode lead shorted to ground 

• RXD Loss – indicates loss of Receive Data 

• DSR Shorted – indicates Data Set Ready lead shorted to ground 

• Bipolar Violation – indicates excessive Bipolar Violations in received signal 

• Jitter – indicates excessive Jitter in received signal 

• Signal To Noise – indicates poor signal to noise ratio in received signal 

• Rx Signal Low – indicates weak received signal 

Informational Alarms

• Front Panel Test – indicates the DSU has been commanded into a test mode by m
its front panel switches 

• DSR Loss – indicates loss of Data Set Ready 

• DTR Loss – indicates loss of Data Terminal Ready 

• TXD Loss – indicates no transmit data from the DTE

• STC Loopback – indicates the DSU has been commanded into a test mode by the
Serving Test Center (STC) 
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Alarm Detail Window Menus

The Alarm Detail window has a File menu and a View menu in its menu bar. 

The File menu contains the selections Demand Poll, Auto Poll, and Exit. Selecting Demand
causes an immediate update of the display. 

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable auto
polling. If you select Disable, the Alarm Detail window displays a static snapshot of condition
they were at the last poll, either when the window was launched or a subsequent Demand P

The time of the most recent poll appears in the bottom left corner of the window. The time is
displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

The View menu consists of three selections: Major, Minor, and Informational, each with a ch
box beside it. To remove an alarm category from the window display, click on its check box s
it is unchecked. Clicking a box so that it is checked restores the corresponding category to t
display. 
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DTE Status

You can launch the NMS 520 DTE Status application from the submap Performance Menu o
the front panel menu. The application displays the read-only DTE Status window for the sel
DSU (See Figure 6-4). The window displays indicators for the states of the EIA signals at the D
interface. Dark green indicates Off, light green indicates On, and light green with a superimp
two-headed arrow indicates transitions. 

Status Window Menu

The Status window has a File menu in its menu bar with the selections Demand Poll, Auto Po
Exit. 

Selecting Demand Poll causes an immediate update of the display. 

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable auto
polling. If you select Disable, the Status window displays a static snapshot of the EIA indicat
they were at the last poll, either when the window was launched or a subsequent Demand P

The time of the most recent poll appears in the bottom left corner of the window. The time is
displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

Figure 6-4 DTE Status Window
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Line Statistics

You can launch the Line Statistics application from the submap Performance Menu or from 
front panel menu. As shown in Figure 6-5, the application displays nine categories of line 
performance statistics accumulated by the unit over the most recent 15 minutes. The statist
displayed on 15 lines, each representing one minute of the displayed interval. The Minute In
column simply identifies the time frame for the other eight items in the row. 

The Status column can display Normal or No Signal. The Transmit Level and Receive Leve
columns display the strength, in decibels, of the signals being sent and received by the DSU
Signal to Noise Ratio column indicates the extent to which useful signal exceeds incidental 
The Signal Quality column indicates the overall condition of the signal being received during
minute. The Phase Jitter column displays the percentage by which phase shift in the received
exceeds acceptable levels. BPV Count displays the number of instances that occurred durin
minute when consecutive ones in the signal being received did not alternate states, thus cons
a bipolar violation. The Frame Loss column displays the number of times during the minute 
framing bits could not be identified. 

Line Statistics Window Menus

The Line Statistics window has a File menu that consists of Refresh and Exit selections. Th
Refresh selection causes the window to display the latest available data. The window is not
dynamic display, so you should use the Refresh selection occasionally when you keep the w
open for long periods. The Exit selection dismisses the Line Statistics window. 

Figure 6-5 Line Statistics Window
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Configuration Functions – Configure
You can launch the NMS 520 Configuration function from the submap Configuration Menu or 
the front panel menu. When you launch the window, it initially displays the read-only NMS 5
Configuration window, which has a File menu and a Navigate menu in its menu bar. 

The File menu contains the selections 

• Refresh, which discards all unsaved changes and restores all options in the displayed 
configuration windows to the values they are assigned by the current operating configur

• Save to Unit, which puts the new configuration into use by the DSU 

• Load Template, by which you can recall a stored configuration template that you can then
to the DSU either with or without modifications 

• Save to Template, by which you can store the current configuration on the workstation f
future use as a template 

• Compare to Template, by which you can identify differences between the configuration 
displayed on-screen and a selected template 

• Exit, by which you can dismiss the window. 

The Navigate menu enables you to access the four read/write windows by which you can con
various aspects of DSU operation: 

• System Options

• Network Options

• DTE Options

• Alarms Reported

Main Configuration Window

The Main Configuration window has two pull down menus, File and Navigate, that are the m
by which you carry out the actual process of configuring the DSU. From the Navigate menu you 
select the individual configuration windows in which you make changes. The File menu commands 
the storage and retrieval of configuration settings. The contents of the two menus appear be

Menu Buttons Menu Selections
Further 

Selections

File

Refresh

Save to Unit

Load Template dialog window

Save to Template dialog window

Compare to Template dialog window

Exit

Navigate
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The Main Configuration window title bar displays the function name, NMS 520 Configuration.
main body of the window contains read-only items that identify the DSU and provide informa
about its operations. 

Main Configuration Window Read-Only Display

The Main Configuration window displays the following read-only items:

Figure 6-6 Main Configuration Window

System Options... 

Network Options... 

DTE Options... 

Alarms Reported... 

All Screens... 

Name: shelf and slot identification for the master DSU followed by the 
slot:line:drop address of the remote NMS 520 DSU

Serial Number: displays the serial number of the NMS 520 DSU

Firmware Revision: displays the revision level of the NMS 520 DSU operating code 
(minimum required for compatibility: L-) 

DDS MIB Version: displays the revision level of the MIB files that enable SNMP control 

NMS 520 MIB Version: displays the revision level of the MIB files that enable SNMP control 

Menu Buttons Menu Selections
Further 

Selections
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System Options

The NMS 520 System Options configuration window contains three options. 

Figure 6-7 NMS 520 System Options Configuration Window

Alarm Scan – permits you to enable or inhibit (disable) alarm trap generation by the SCM. 

Options:

• Enable 

• Disable 

Front Panel – permits you to disable the switches on the front panel of the DSU as protectio
against any inadvertent interruption of its operation. 

Options:

• Enable – DSU front panel switches are operational. 

• Disable – DSU front panel switches are disabled. 

Rsp Timeout – selects the length of time the SCM waits for a response from the DSU before
declares a No Response condition. 

Options:

• 2, 4, 6, 8 seconds
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NMS 520 Network Options

The NMS 520 Network Options configuration window (Figure 6-8) appears when you select 
Network Options from the Main Configuration window Navigate menu. The window contains
panels labeled Network Parameters and Circuit Parameters. 

Figure 6-8 NMS 520 Network Options Configuration Window

Network Parameters

Line Type – read-only field displays the type of service to which the DSU is connected

Options:

• Clear Channel 

• DDS-I 

• DDS-SC 

Carrier  – selects the combination of transmit and receive carrier modes (constant/switched)
used by the DSU 

Options:

• Tx Constant, Rx Constant – for use on a point-to-point circuit 

• Tx Constant, Rx Switched – for use when the DSU is the master unit on a multi-point
circuit 

• Tx Switched, Rx Constant – for use when the DSU is a remote unit on a multi-point circ

• Tx Switched, Rx Switched – for use when required by specialized applications

Data Rate – read-only field displays the data rate and mode (synchronous/asynchronous) in u
the DSU 
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Options:

• 2.4 Kbps - Async 

• 2.4 Kbps - Sync 

• 4.8 Kbps - Async 

• 4.8 Kbps - Sync 

• 9.6 Kbps - Async 

• 9.6 Kbps - Sync 

• 19.2 Kbps - Async 

• 19.2 Kbps - Sync 

• 56 Kbps - Sync 

• 64 Kbps - Sync 

Circuit Parameters

Tx Clock Source – displays the source of transmit timing for the DSU; this item is read only a
grayed out

Options:

• Receive – transmit timing based on receive data timing

• Internal – transmit timing provided by the DSU internal clock 

• External – transmit timing provided by the DTE; the Buffer Clock option is forced to
External and cannot be changed when this is selected 

Buffer Clock – selects the source of timing for the buffer between the DSU and its DTE 

Options:

• Internal – selects timing provided by the DSU internal clock 

• External – selects timing provided by the DTE; when External is selected for Tx Clo
Source this selection is forced and cannot be changed 

Zero Encoding – selects Zero Encoding, which 56 kbps DDS-SC applications require to ensur
primary and secondary channels do not transmit all spaces (zeros) at the same time 

Options:

• Enable – DSU prevents the all space condition at the expense of reduced seconda
channel bandwidth 

• Disable – DSU does not prevent the all space condition 

Sentry Timer – selects the minimum time interval permitted between alarm reports in a DDS
clear channel point-to-point link; setting configured here must match that in the SC 521 DSU

Options:

• Disable 

• 1 Minute to 5 Minutes – in one minute increments
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• 10 Minutes 

• 15 Minutes to 60 Minutes – in 15 minute increments (Default 60) 

• 90 Minutes

• 120 Minutes 

Rmt Rsp Interval – selects the minimum time interval permitted between alarm reports in a D
multi-point link; SC 521 DSU and all remote NMS 520 DSUs must be configured to the sam
setting 

Options:

• Disable 

• 10 Seconds to 120 Seconds – in ten second increments 

Alarm Hysteresis – selects the minimum time an alarm condition must persist in order to be 
reported 

Options:

• 10 Seconds to 120 Seconds – in ten second increments 

Circuit Assurance – when this option is enabled the DSU clamps Clear To Send when it det
any of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or 
Inactive Channel Code 

Options:

• Disable 

• Enable 

System Status – when this option is enabled the DSU clamps Data Set Ready when it detect
of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or Inact
Channel Code 

Options:

• Disable 

• Enable 
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DTE Options

The NMS 520 DTE Options configuration window contains four groups of options under the
headings Interface, Control Parameters, Async Parameters, and Diagnostic Parameters. 

Figure 6-9 DTE Options Configuration Window

Interface 

Interface Type – specifies the DTE port type 

Options:

• RS232 – EIA/TIA-232-E interface 

• V.35 – ITU-T V.35 interface 

• Auto – the DSU automatically senses the interface type being used by the DTE 

Interface Adapter – read-only field displays whether or not the DSU has a Data Rate Adapte
(DRA) card installed 

Options:

• None 

• Installed 

Data Type – selects the DSU to function with either synchronous or asynchronous data from
DTE; this option is available only for data rates of 19.2 kbps and less
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Options:

• Sync 

• Async 

Control Parameters

AAS – selects whether or not the DSU provides Automatic Anti-Streaming protection, and the
limit it enforces when the feature is enabled 

Options: 

• Disable

• 5 Seconds

• 10 Seconds

• 30 Seconds

• 45 Seconds

Constant DSR – selects the DSU to output either a constant or a switched Data Set Ready s
to its DTE. 

Options: 

• Disable – switched DSR signal controlled by DTR 

• Enable – constant DSR signal

CTS Delay – selects the delay (if any) between the DSU receiving Request To Send from the
and returning Clear To Send to the DTE. 

Options: 

• CTS ON – no delay; grayed out when Tx Constant is selected in the Carrier option o
Network Options configuration window

• Fixed 3 Char – equivalent to three character times 

• 0 msec 

• 30 msec 

• 60 msec 

• 90 msec 

HDLC Invert – selects whether or not the DSU uses inverted channel data from the DTE. D
inversion is used primarily with DDS-SC 56 kbps circuits, to enhance data quality in a networ
does not provide B8ZS coding. 
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Options: 

• Disable – normal data 

• Enable – inverted data

Async Parameters

The Async Parameters options are grayed out when a synchronous Data Rate is selected in
Network Interface configuration. 

Character Size – selects the number of bits per asynchronous character, including start and
bits 

Options: 

• 11 Bits 

• 10 Bits 

• 9 Bits 

• 8 Bits 

Overspeed – selects the percentage above its configured normal operating rate at which the
can accommodate receive data. It performs the over speed compensation by shaving stop b

Options: 

• 1%

• 2.3%

Suppression – determines what actions the DSU takes concerning transmit and receive End o
(EOT) 

Options: 

• Disable – the DSU does not insert EOT at the end of transmissions, and does not d
it from the end of received signals 

• Rx EOT – the DSU deletes EOT from the end of received signals; it does not insert 
at the end of transmissions 

• Tx EOT – the DSU inserts EOT at the end of transmissions; it does not delete it from
end of received signals 

Warning You must consider the following factors when you change the setting of this option: 

When changing the setting of this option, set only this option and save the change to the unit. Do
combine it with any other configuration changes. 

The option must be set the same at both ends of the link. 

You must make changes at the remote DSU first, before you change the option setting at the maste
Changing the option at the remote results in an “SNMP ‘Set’ Request Failed” error message and ca
loss of communication between the remote and master units. Click on OK in the error message box
dismiss the message, then proceed to change the option setting at the master. Communication res
when the option change goes into effect at the master unit.
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• Rx + Tx EOT – the DSU inserts EOT at the end of transmissions, and deletes it from
end of received signals 

Rate Adaption – specifies the DTE interface operating rate when it is below that of the DDS
circuit; valid only when Data Rate in the Network Options screen is set to 2.4 Kbps - Async

Options: 

• Disable 

• 600 

• 1200 

• 1800 to 2400 

Diagnostic Parameters

Data Set Ready – selects how the DSU controls the DSR output to the DTE during test mode

Options:

• Off During LL Test 

• Normal – DSR operates in the same way that it is optioned to function during data m
operations 

Line Loopback Test Points – selects whether a Line Loopback command causes the DSU on
loop transmit data back to the DTE, or also to loop receive data back to the network 

Options: 

• DTE Only – Line Loopback command causes DSU to loop data back to DTE only 

• Network & DTE – Line Loopback command causes DSU to loop data in both direc
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Alarms Reported

The NMS 520 Alarms Reported configuration window (Figure 6-10) lets you configure which 
alarm conditions are to be reported for the DSU and which are not. The window contains th
panels labeled Network, DTE, and Unit as shown below. 

Figure 6-10 Alarms Reported Configuration Window

Buttons and Option Selection

Each of the alarm options in the Alarms Reported configuration window has a small selection
located to its left. You can select or de-select individual alarm options by simply clicking the m
button on the appropriate selection fields. When an option is selected for its alarm to be rep
its selection field is highlighted. The selection fields next to alarm options that are not to be rep
are not highlighted. 

The Alarms Reported configuration window has two buttons positioned above the option fie
Report All and Report None:

• Click on Report All to highlight all the alarm option selection fields. 

• Click on Report None to remove the highlight from all the alarm option selection fields. 

After clicking Report All or Report None you can then change the state of individual fields as
needed. 

Alarms Reported Buttons

Report All  – unmasks all alarms.

Report None – masks all alarms.

OK  – saves your changes and closes the window.
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Reset – replaces the information in the fields with the most recently read information from the D 
Note that this button does not initiate a read of information from the DSU.

Cancel – cancels your changes and closes the window.

Network Alarms

Each Network alarm, when unmasked, requires you to specify a threshold against which it i
evaluated. 

Alarm Interval  - determines the time span for threshold evaluation. 

Options:

• 1 min, 5 min, 10 min, 15 min 

Bipolar Violation - lets you mask or unmask Bipolar Violation (BPV) alarms. A network BPV
occurs when the signal the unit receives at its network interface does not alternate between
levels as required for Alternate Mark Inversion (AMI) or Bipolar with 8 Zero Substitution (B8Z
data encoding. The alarm occurs when the number of Bipolar Violations in the received sign
during one Alarm Interval exceeds the selected threshold. 

Options:

• 1, 2, 5, 10, 20, 40, 60, 80, 99 

Jitter  - lets you mask or unmask Jitter alarms. The alarm occurs when the percent of jitter in
received signal remains above the selected threshold for at least one Alarm Interval. 

Options:

• 1%, 2%, 5%, 10%, 20%, 40%, 60%, 80%, 99% 

Frame Loss - lets you mask or unmask Frame Loss alarms. The alarm occurs when the num
lost frames in the received signal during one Alarm Interval exceeds the selected threshold.

Options:

• 1, 2, 5, 10, 20, 40, 60, 80, 99 

Rx Signal Low - lets you mask or unmask Rx Signal Low alarms. The alarm occurs when th
strength of the received signal remains below the selected threshold for at least one Alarm In

Options:

• -50 dB, -40 dB, -30 dB, -20 dB, -10 dB, -5 dB, 0 dB, 6 dB 

Signal to Noise - lets you mask or unmask Signal to Noise Ratio alarms. The alarm occurs w
the ratio of signal to noise in the received signal remains poorer than the selected threshold
least one Alarm Interval. 

Options:

• 0, 5, 10, 15, 20, 25, 30, 40, 50 

DTE

• DTP Loss – indicates loss of Data Terminal Power 

• DCD Loss – indicates loss of Data Carrier Detect 

• DSR Loss – indicates loss of Data Set Ready 
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• DTR Loss – indicates loss of Data Terminal Ready 

• RxD Loss – indicates no receive data from the remote DSU 

• TxD Loss – indicates no transmit data from the DTE 

• TM Shorted – indicates a short circuit on the Test Mode interface lead 

• Streaming – indicates a streaming condition at the DTE interface 

• DCD Shorted – indicates a short circuit on the Data Carrier Detect interface lead 

• DSR Shorted – indicates short circuit on the Data Set Ready interface lead 

• CTS Shorted – indicates a short circuit on the Clear To Send interface lead 

• RxD Shorted – indicates a short circuit on the Receive Data interface lead 

• RxC Shorted – indicates a short circuit on the Receive Timing interface lead 

• TxC Shorted – indicates a short circuit on the Transmit Timing interface lead 

Unit

• No Signal – indicates there is no signal at the DSU network interface 

• Line Pairs Reversed – indicates the transmit and receive line pairs are reversed 

• STC Loopback – indicates the DSU has been commanded into a test mode by the Telco Se
Test Center (STC) 

• Front Panel Test – indicates the DSU has been commanded into a test mode by means o
front panel switches

• No Loop Current – indicates that network sealing current is inadequate or absent 

• EEPROM Checksum – indicates Configuration Checksum error 

Configuration Functions – Maintenance
You can launch the NMS 520 Maintenance function from the submap Configuration Menu or
the front panel menu. The application displays one read/write window by which you can con
some aspects of DSU operation that fall outside the scope of the Configure application. See Figure 
6-11. 

The window title bar displays the function name, NMS 520 Maintenance. The Name field dis
the shelf name and the slot number of the master DSU followed by the slot:line:drop address
remote DSU. The File menu contains only the selection Exit, by which you can dismiss the wi
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Maintenance Window Buttons

The Maintenance window provides the following two buttons. 

Reset to Factory Defaults – causes all options in the DSU to return to their factory default settin
When you click on this button the application displays a warning “Resetting to factory defaults
terminate communications to the unit. Do you want to continue?” Click on the OK button in t
warning window to complete the reset, or click on the Cancel button to cancel the reset. 

Perform Soft Reset – causes the DSU to perform a reset and resume operation using its cur
configuration. When you click on this button the application displays a warning “Performing a
reset will disrupt communications to the unit. Do you want to continue?” Click on the OK butto
the warning window to complete the reset, or click on the Cancel button to cancel the reset.

Figure 6-11 Maintenance Window

Diagnostics

You can launch the NMS 520 Diagnostics function from the submap Fault menu or from the
panel menu. 

The application displays one read/write window by which you can control a variety of test func
on the DSU. 

Diagnostics Window

Beneath the menu bar and the Name field the Diagnostics window (See Figure 6-12) is divided into 
three areas:

• Selection panel – contains buttons and check boxes for selecting, starting, and stopping
functions

• Graphic panel – depicts the path followed by test data during the current test 

• Duration and results panel – contains an input field for specifying how many blocks of da
use for a test that employs the DSU test pattern generator; displays Test Duration, Time
Remaining, and Test Results 
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The Diagnostics window menu bar contains File and Navigate. The File menu has only the 
selection by which you dismiss the window. The Navigate menu also has a single selection: H
by which you can access a display of test results (see Figure 6-13) accumulated during the curren
diagnostic session. 

Tests

The Diagnostics window selection panel lists three Tests to choose from, and three Patterns y
select for those tests that employ the DSU test pattern generator. The panel also includes a
field for the User Defined test pattern, and two buttons: Start Test and Stop Test. 

The following Tests are available: 

• Line Loop (performed only with test pattern) 

• End To End (performed only with test pattern) 

• Dataloop (can be performed with or without test pattern) 

• Delay Test 

The Patterns are: 

• 511 bit 

• 2047 bit 

• 15 bit 

Each Test and Pattern is accompanied by a check box on which you can click to select it. The 
check boxes are grayed out when the selected Test cannot be combined with an internal test

Diagnostic Test Procedure

Perform the following steps to select and carry out a test procedure on the DSU. 

1. Click on the check box next to the selected test. If you are running the Delay Test, go to S

2. Under the Pattern heading, click on your selected pattern. The Dataloop test also suppo
selection None (for external data). 

3. If you are using an internally generated test pattern select, in the Test Blocks field, how 
data is to run before the test ends automatically. 

4. Click on the Start Test button. While the test runs, the graphic panel illustrates the data 
employed by the test. If you are using an internally generated test pattern, the Time Rem
field counts down from 100 to 0 percent. 

5. During a test that employs an internally generated test pattern the Test Results field disp
the number of errors detected; it displays In Loop when external data is in use. 

6. If you are using an internally generated test pattern, the test ends automatically when th
specified number of data blocks have run. For any other test, click on the Stop Test butto
end the procedure. 
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Note Following any test except Dataloop a pop up window appears with the message Network element 
communication problem. Try again. 

The message results from the interruption caused by the test. Normal operation should resume whe
click on the OK box to dismiss the pop up.
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Diagnostics Table

The table below briefly describes the available tests.

Diagnostics History

You can view a record of tests performed during the current diagnostic session by selecting H
from the Navigate menu in the Diagnostics window. The record appears as a listing in the 
Diagnostics History window (see Figure 6-13). 

Figure 6-13 Diagnostics History

The Diagnostics History displays information in five columns:

• Start Time – date and time test began 

• Test – name of the test 

• Pattern – test pattern used for the test; N/A when internally generated pattern is not use

Test Description

Line Loop 
(with Pattern)

DSU initiates a loopback at its network interface and activates its test pattern 
generator/checker.

End To End 
(with Pattern)

Remote NMS 520 DSU activates its test pattern generator/checker and 
transmits the pattern on its link to the master SC 521 DSU. Remote DSU 
checks for errors in the signal it receives, which is generated by the master 
DSU. 

Dataloop 
(without 
Pattern)

Remote NMS 520 DSU transmits a command on the link that causes the 
master SC 521 DSU to loop data back to the Remote DSU; DTE or external 
test equipment at the remote DSU is responsible for generating and checking 
a test pattern. 

Dataloop
(with Pattern)

Remote NMS 520 DSU transmits the loopback command to the master SC 
521 DSU, and activates its test pattern generator/checker to transmit the 
pattern and check for errors in the signal it receives back. 

Delay Test Remote NMS 520 DSU transmits and receives a test signal, which is looped 
back by the master SC 521 DSU; the Remote DSU measures the round trip 
time (delay). 
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• Test Blocks – number of data blocks sent during the test, applies only to tests with test p

• Test Results – “Idle: n/n Bit/Block Errors” for a completed test with test pattern; “Not in loo
[STOPPED]” for a completed loop test without test pattern; “TEST STOPPED” for any te
with test pattern that was ended by the Stop Test button; “n ms.” for Delay Test

To close the Diagnostics History window, click on either the OK button or the pushpin icon in
upper left corner of the window. During an on-going diagnostic session you can close and re
the Diagnostics History window without loss of display data. 

The application clears the Diagnostics History when you exit from the Diagnostics window. 

Miscellaneous Functions 
The submap Misc Menu has selections for Front Panel Poll Rate and Note Pad. These sele
access the same applications that are described in Chapter 2. 
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Chapter 7: NMS 510

Overview

The SC 521 Data Service Unit (DSU) can operate in conjunction with an NMS 510 DSU loca
a remote site. The TEAM 521 software supports a full range of functions for the remote NMS
DSU, as it does for the SC 521 DSU. This chapter describes the NMS 510 functionality of th
software and provides instructions for its use. 

Access to the NMS 510 Functions

Access to the NMS 510 functions takes place through the icon for the SC 521 DSU that is lin
the NMS 510 DSU that you intend to work with. 

1. 1.Display the shelf map. Any DSU that does not have an associated remote is identified by 
box around its icon symbol. Each DSU that has an associated remote is identified by an
symbol without a box. 

2. 2.Double click on the icon symbol of the DSU that is linked to the DSU you intend to wo
with. The application responds by opening a submap that displays icons for the two DSU
a connecting line to indicate that together they form a link. 

3. 3.From this submap you can either click once on the DSU icon to select it and then acce
functions through the menu bar of the submap window, or double click on the DSU icon 
open the NMS 510 Front Panel display window. From the Front Panel display you can a
NMS 510 functions through Select button menus. 

Master/Remote Communications

Management communications take place on the secondary channel when the link between 
master SpectraComm 521 DSU and the remote NMS 510 DSU is configured to be DDS II w
secondary channel. 

When the link is configured for DDS I or for clear channel the management communications
occupy the same channel that carries user data. When that is the case, each management 
communication has the effect of briefly interrupting or causing errors in the user data. Error 
correcting protocols and requests for retransmission protect user data against corruption, bu
effect does slightly reduce throughput. 

Note Reduction in throughput caused by management communications is most noticeable when the Fron
Panel display or the Alarm Detail window is open with Auto Poll enabled. The faster the scan rate se
selected for Auto Poll, the greater the effect on user data. 
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Submap Window Menu Bar Access
The table on the following page illustrates how the NMS 510 functions of the TEAM 521 
application are arranged on the menu bar at the top of the HPOV link submap window. The
shows only the menu selections for the NMS 510 functions. The submap window menus inc
other selections as well because the window is accessible to other applications. 

You must click on the DSU icon to select it before you open the menu you intend to use. 

The Performance menu Front Panel selection opens the Front Panel display window, which
provides access to menus through its Select button. All the menu selections shown above ap
the Select button menus except Front Panel in the Performance menu and the two items in th
menu. 

Menu Bar Menu Selections

Performance

Front Panel...

Alarms...

DTE Status...

Configuration

Configure...

Maintenance...

Fault

Diagnose...

Misc

Front Panel Poll Rate...

Note Pad
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NMS 510 DSU Front Panel

The NMS 510 Front Panel display window (See Figure 7-1) provides a graphical interface to a 
remote NMS 510 DSU. You can launch a Front Panel from the link submap, described above
the heading Access to the NMS 510 Functions, in either of two ways: 

• select the NMS 510 icon in the submap window, then select Front Panel from the Perform
menu for the window

• double click the mouse on the NMS 510 icon. 

The application responds by displaying a window that depicts an NMS 510 DSU. The applic
employs the same display regardless of whether or not the selected DSU is equipped with a
Intelligent Front Panel (IFP). 

Figure 7-1 NMS 510 DSU Front Panel

The LEDs shown in the display reflect the states of the actual indicators on the physical uni

• NS – No Signal indicates when lit that there is no signal at the network interface of
remote DSU 

• SD – Send Data indicates when lit that the DSU is transmitting data 

• RD – Receive Data indicates when lit that the DSU is receiving data 

• RS – Request to Send indicates when lit that the DTE has data to transmit 

• CS – Clear to Send indicates when lit that the DSU is prepared to transmit data 

• CO – Carrier On indicates when lit that the DSU is receiving a carrier signal at its net
interface 

• TR – Terminal Ready indicates when lit that the DTE is powered on

• NORM – DSU mode indication, when lit indicates DSU in normal mode; when off 
indicates DSU in diagnostic mode 

• TEST/OK – indicates when lit that the DSU is receiving valid test data 

• DBU – not a valid indicator in the TEAM application environment 

• NETCON CO – not a valid indicator in the TEAM application environment 

• NETCON DATA – not a valid indicator in the TEAM application environment 

• NETCON RESP – not a valid indicator in the TEAM application environment 

• NETCON TEST – not a valid indicator in the TEAM application environment 
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The application polls the DSU to keep the states of the LEDs in the Front Panel display curren
time of the most recent poll appears in the bottom left corner of the Front Panel display. The
is displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

The Select button on the Front Panel displays provides access to menus for the rest of the N
functions of the TEAM 521 application. The following table shows the arrangement of the S
button menus. It differs somewhat from the arrangement on the submap window menu bar.

The two Poll selections in the Select button menu determine when the application collects n
information from the DSU to update the Front Panel window:

• Selecting Demand Poll causes an immediate update of the display. 

• Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable aut
polling. If you select Disable, the Front Panel window displays a static snapshot of the L
states as they were at the last poll, either when the window was launched or a subseque
Demand Poll. 

Each time the Front Panel display is opened, its initial polling rate is determined by the Front
Poll Rate selection of the HPOV map window Misc menu. 

The menu selection Exit dismisses the Front Panel window when you click on it. 

Select Menu Items Selections

Performance

Alarms...

DTE Status...

Configuration

Configure...

Maintenance...

Fault

Diagnose...

Demand Poll

Auto Poll

15 seconds

30 seconds

60 seconds

Disable

Exit
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Alarms

You can launch the NMS 510 Alarm Detail application from the submap Performance Menu
from the front panel menu. The application displays the read-only Alarms Detail window for 
selected DSU (See Figure 7-2).

The TEAM 521 application polls the DSU for changes in alarm conditions.

Figure 7-2 Alarm Detail Window

The Alarm Detail window displays alarms grouped into three categories: 

• Major

• Minor 

• Informational
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Major Alarms

• EEPROM Checksum – indicates that the non-volatile memory that stores the DSU 
configuration has become corrupted

• DTP Loss – indicates loss of Data Terminal Power 

• DCD Loss – indicates loss of Data Carrier Detect 

• No Signal – indicates no signal at the DSU network interface 

• Streaming – indicates constant RTS condition at the DTE interface

• Frame Loss – indicates loss of framing 

Minor Alarm

• RXD Loss – indicates loss of Receive Data 

Informational Alarms

• Front Panel Test – indicates the DSU has been commanded into a test mode by means
front panel switches 

• DSR Loss – indicates loss of Data Set Ready 

• DTR Loss – indicates loss of Data Terminal Ready 

• TXD Loss – indicates no transmit data from the DTE

• STC Loopback – indicates the DSU has been commanded into a test mode by the Telco S
Test Center (STC) 

Alarm Detail Window Menus

The Alarm Detail window has a File menu and a View menu in its menu bar. 

The File menu contains the selections Demand Poll, Auto Poll, and Exit. Selecting Demand
causes an immediate update of the display. 

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable auto
polling. If you select Disable, the Alarm Detail window displays a static snapshot of condition
they were at the last poll, either when the window was launched or a subsequent Demand P

The time of the most recent poll appears in the bottom left corner of the window. The time is
displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

The View menu consists of three selections: Major, Minor, and Informational, each with a ch
box beside it. To remove an alarm category from the window display, click on its check box s
it is unchecked. Clicking a box so that it is checked restores the corresponding category to t
display. 

DTE Status

You can launch the NMS 510 DTE Status application from the submap Performance Menu o
the front panel menu. The application displays the read-only DTE Status window for the sel
DSU (See Figure 7-3). The window displays indicators for the states of the EIA signals at the D
interface. Dark green indicates Off, light green indicates On, and light green with a superimp
two-headed arrow indicates transitions. 
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Status Window Menu

The Status window has a File menu in its menu bar with the selections Demand Poll, Auto Po
Exit. 

Selecting Demand Poll causes an immediate update of the display. 

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable auto
polling. If you select Disable, the Status window displays a static snapshot of the EIA indicat
they were at the last poll, either when the window was launched or a subsequent Demand P

The time of the most recent poll appears in the bottom left corner of the window. The time is
displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

Figure 7-3 DTE Status Window

Configuration Functions – Configure

You can launch the NMS 510 Configure function from the submap Configuration Menu or from
front panel menu. When you launch the window, it initially displays the read-only NMS 510 
Configuration window, which has a File menu and a Navigate menu in its menu bar. 

The File menu contains the selections 

• Refresh, which discards all unsaved changes and restores all options in the displayed 
configuration windows to the values they are assigned by the current operating configur
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• Save to Unit, which puts the new configuration into use by the DSU 

• Load Template, by which you can recall a stored configuration template that you can then
to the DSU either with or without modifications 

• Save to Template, by which you can store the current configuration on the workstation f
future use as a template 

• Compare to Template, by which you can identify differences between the configuration 
displayed on-screen and a selected template 

• Exit, by which you can dismiss the window. 

The Navigate menu enables you to access the four read/write windows by which you can con
various aspects of DSU operation: 

• System Options

• Network Options

• DTE Options

• Alarms Reported

Main Configuration Window

The Main Configuration window has two pull down menus, File and Navigate, that are the m
by which you carry out the actual process of configuring the DSU. From the Navigate menu you 
select the individual configuration windows in which you make changes. The File menu commands 
the storage and retrieval of configuration settings. The contents of the two menus appear be

Menu Buttons Menu Selections
Further 

Selections

File

Refresh

Save to Unit

Load Template dialog window

Save to Template dialog window

Compare to Template dialog window

Exit

Navigate

System Options... 

Network Options... 

DTE Options... 

Alarms Reported... 

All Screens... 
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The Main Configuration window title bar displays the function name, NMS 510 Configuration.
main body of the window contains read-only items that identify the DSU and provide informa
about its operations. 

Main Configuration Window Read-Only Display

The Main Configuration window displays the following read-only items:

Figure 7-4 Main Configuration Window

System Options

The NMS 510 System Options configuration window contains two options. 

Figure 7-5 Figure 7-5NMS 510 System Options Configuration Window

Front Panel – permits you to disable the switches on the front panel of the DSU as protectio
against any inadvertent interruption of its operation. 

Options:

• Enable – DSU front panel switches are operational. 

Name: shelf and slot identification for the master DSU followed by the 
slot:line:drop address of the remote NMS 510 DSU

Serial Number: displays the serial number of the NMS 510 DSU

Firmware Revision: displays the revision level of the NMS 510 DSU operating code

DDS Version: displays the revision level of the MIB files that enable SNMP control 

NMS 510 MIB Version: displays the revision level of the MIB files that enable SNMP control 
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• Disable – DSU front panel switches are disabled. 

Rsp Timeout – selects the length of time the SCM waits for a response from the DSU before
declares a No Response condition. 

Options:

• 2, 4, 6, 8 seconds

NMS 510 Network Options

The NMS 510 Network Options configuration window (Figure 7-6) appears when you select 
Network Options from the Main Configuration window Navigate menu. The window contains
panels labeled Network Parameters and Circuit Parameters. 

Figure 7-6 NMS 510 Network Options Configuration Window

Network Parameters

Line Type – read-only field displays the type of service to which the DSU is connected

Options:

• Clear Channel 

• DDS-I 

• DDS-SC 

Carrier  – selects the combination of transmit and receive carrier modes (constant/switched)
used by the DSU 

Options:
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• Tx Constant, Rx Constant – for use on a point-to-point circuit 

• Tx Constant, Rx Switched – for use when the DSU is the master unit on a multi-point
circuit 

• Tx Switched, Rx Constant – for use when the DSU is a remote unit on a multi-point circ

• Tx Switched, Rx Switched – for use when required by specialized applications

Data Rate – read-only field displays the data rate and mode (synchronous/asynchronous) in u
the DSU 

Options:

• 2.4 Kbps - Async 

• 2.4 Kbps - Sync 

• 4.8 Kbps - Async 

• 4.8 Kbps - Sync 

• 9.6 Kbps - Async 

• 9.6 Kbps - Sync 

• 19.2 Kbps - Async 

• 19.2 Kbps - Sync 

• 56 Kbps - Sync 

• 64 Kbps - Sync 

Circuit Parameters

Tx Clock Source – displays the source of transmit timing for the DSU; this item is read only a
grayed out 

Options:

• Receive – transmit timing based on receive data timing

• Internal – transmit timing provided by the DSU internal clock 

• External – transmit timing provided by the DTE; the Buffer Clock option is forced to
External and cannot be changed when this is selected 

Buffer Clock – selects the source of timing for the buffer between the DSU and its DTE 

Options:

• Internal – selects timing provided by the DSU internal clock 

• External – selects timing provided by the DTE; when External is selected for Tx Clo
Source this selection is forced and cannot be changed 

Zero Encoding – selects Zero Encoding, required for 56 kbps DDS-SC applications in which
primary and secondary channels are not permitted to transmit all spaces (zeros) at the sam

Options:

• Enable – DSU prevents the all space condition at the expense of reduced seconda
channel bandwidth 
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• Disable – DSU does not prevent the all space condition 

Circuit Assurance – when this option is enabled the DSU clamps Clear To Send when it det
any of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or 
Inactive Channel Code 

Options:

• Disable 

• Enable 

System Status – when this option is enabled the DSU clamps Data Set Ready when it detect
of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or Inact
Channel Code 

Options:

• Disable 

• Enable 

DTE Options

The NMS 510 DTE Options configuration window contains four groups of options under the
headings Interface, Control Parameters, Async Parameters, and Diagnostic Parameters. 

Figure 7-7 DTE Options Configuration Window
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Interface 

Interface Adapter – read-only field displays whether or not the DSU has a Data Rate Adapte
(DRA) card installed 

Options:

• None 

• Installed 

Data Type – selects the DSU to function with either synchronous or asynchronous data from
DTE; this option is available only for data rates of 19.2 kbps and less

Options:

• Sync 

• Async 

Control Parameters

AAS – selects whether or not the DSU provides Automatic Anti-Streaming protection, and the
limit it enforces when the feature is enabled 

Options: 

• Disable

• 5 Seconds

• 10 Seconds

• 30 Seconds

• 45 Seconds

Constant DSR – selects the DSU to output either a constant or a switched Data Set Ready s
to its DTE. 

Options: 

• Disable – switched DSR signal controlled by DTR 

• Enable – constant DSR signal

CTS Delay – selects the delay (if any) between the DSU receiving Request To Send from the
and returning Clear To Send to the DTE. 

Options: 

• CTS ON – no delay; grayed out when Tx Constant is selected in the Carrier option o
Network Options configuration window

• Fixed 3 Char – equivalent to three character times 

• 0 msec 

• 30 msec 

• 60 msec 

• 90 msec 
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HDLC Invert – selects whether or not the DSU uses inverted channel data from the DTE. D
inversion is used primarily with DDS-SC 56 kbps circuits, to enhance data quality in a networ
does not provide B8ZS coding. 

Options: 

• Disable – normal data 

• Enable – inverted data

Async Parameters

The Async Parameters options are grayed out when a synchronous Data Rate is selected in
Network Interface configuration. 

Character Size – selects the number of bits per asynchronous character, including start and
bits 

Options: 

• 11 Bits 

• 10 Bits 

• 9 Bits 

• 8 Bits 

Overspeed – selects the percentage above its configured normal operating rate at which the
can accommodate receive data. It performs the over speed compensation by shaving stop b

Options: 

• 1% 

• 2.3%

Suppression – determines what actions the DSU takes concerning transmit and receive End o
(EOT) 

Options: 

• Disable – the DSU does not insert EOT at the end of transmissions, and does not d
it from the end of received signals 

• Rx EOT – the DSU deletes EOT from the end of received signals; it does not insert 
at the end of transmissions 

Warning You must consider the following factors when you change the setting of this option: 

When changing the setting of this option, set only this option and save the change to the unit. Do
combine it with any other configuration changes. 

The option must be set the same at both ends of the link. 

You must make changes at the remote DSU first, before you change the option setting at the DS
Changing the option at the remote results in an “SNMP ‘Set’ Request Failed” error message and ca
loss of communication between the remote and master units. Click on OK in the error message box
dismiss the message, then proceed to change the option setting at the master. Communication res
when the option change goes into effect at the master unit.
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• Tx EOT – the DSU inserts EOT at the end of transmissions; it does not delete it from
end of received signals 

• Rx + Tx EOT – the DSU inserts EOT at the end of transmissions, and deletes it from
end of received signals 

Rate Adaption – specifies the DTE interface operating rate when it is below that of the DDS
circuit; valid only when Data Rate in the Network Options screen is set to 2.4 Kbps - Async 

Options: 

• Disable 

• 600 

• 1200 

• 1800 to 2400 

Diagnostic Parameters

Data Set Ready – selects how the DSU controls the DSR output to the DTE during test mode

Options:

• Off During LL Test 

• Normal – DSR operates in the same way that it is optioned to function during data m
operations 

Line Loopback Test Points – selects whether a Line Loopback command causes the DSU on
loop transmit data back to the DTE, or also to loop receive data back to the network 

Options: 

• DTE Only – Line Loopback command causes DSU to loop data back to DTE only 

• Network & DTE – Line Loopback command causes DSU to loop data in both direc
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Alarms Reported

The NMS 510 Alarms Reported configuration window (Figure 7-8) lets you configure which alarm
conditions are to be reported for the DSU and which are not. The window contains three pa
labeled Network, DTE, and Unit as shown below. 

Figure 7-8 Alarms Reported Configuration Window

Buttons and Option Selection

Each of the alarm options in the Alarms Reported configuration window has a small selection
located to its left. You can select or de-select individual alarm options by simply clicking the m
button on the appropriate selection fields. When an option is selected for its alarm to be rep
its selection field is highlighted. The selection fields next to alarm options that are not to be rep
are not highlighted. 

The Alarms Reported configuration window has two buttons positioned above the option fie
Report All and Report None:

• Click on Report All to highlight all the alarm option selection fields. 

• Click on Report None to remove the highlight from all the alarm option selection fields. 

After clicking Report All or Report None you can change the state of individual fields as nee

Alarms Reported Buttons

Report All  – unmasks all alarms.

Report None – masks all alarms.
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Reset – replaces the information in the fields with the most recently read information from the D 
Note that this button does not initiate a read of information from the DSU.

OK  – saves your changes and closes the window.

Cancel – cancels your changes and closes the window.

Network

Frame Loss is the one Network alarm. When it is unmasked you must specify a threshold fo
evaluating the alarm condition. 

Alarm Interval  - determines the time span for threshold evaluation. 

Options:

• 1 min, 5 min, 10 min, 15 min 

Frame Loss - lets you mask or unmask Frame Loss alarms. The alarm occurs when the num
lost frames in the received signal during one Alarm Interval exceeds the selected threshold.

Options:

• 1, 2, 5, 10, 20, 40, 60, 80, 99 

DTE

• DTP Loss – indicates loss of Data Terminal Power 

• DCD Loss – indicates loss of Data Carrier Detect 

• DSR Loss – indicates loss of Data Set Ready 

• DTR Loss – indicates loss of Data Terminal Ready 

• RXD Loss – indicates no receive data from the remote DSU 

• TXD Loss – indicates no transmit data from the DTE 

• Streaming – indicates a streaming condition at the DTE interface 

Unit

No Signal – indicates no signal at the DSU network interface 

STC Loopback – indicates the DSU has been commanded into a test mode by the Telco Servin
Center (STC) 

Front Panel Test – indicates the DSU has been commanded into a test mode by means of its
panel switches

EEPROM Checksum – indicates configuration checksum error 

Configuration Functions – Maintenance
You can launch the NMS 510 Maintenance function from the submap Configuration Menu or
the front panel menu. The application displays one read/write window by which you can con
some aspects of DSU operation that fall outside the scope of Configuration. See Figure 7-9. 

The window title bar displays the function name, NMS 510 Maintenance. The Name field dis
the shelf name and the slot number of the master DSE followed by the slot:line:drop address
DSU. The File menu contains only the selection Exit, by which you can dismiss the window.
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Maintenance Window Buttons

The Maintenance window provides the following two buttons. 

Reset to Factory Defaults – causes all options in the DSU to return to their factory default settin
When you click on this button the application displays a warning “Resetting to factory defaults
terminate communications to the unit. Do you want to continue?” Click on the OK button in t
warning window to complete the reset, or click on the Cancel button to cancel the reset. 

Perform Soft Reset – causes the DSU to perform a reset and resume operation using its cur
configuration. When you click on this button the application displays a warning “Performing a
reset will disrupt communications to the unit. Do you want to continue?” Click on the OK butto
the warning window to complete the reset, or click on the Cancel button to cancel the reset.

Figure 7-9 Maintenance Window

Diagnostics
You can launch the NMS 510 Diagnostics function from the submap Fault Menu or from the
panel menu. 

The application displays one read/write window by which you can control a variety of test func
on the DSU. 

Diagnostics Window

Beneath the menu bar and the Name field the Diagnostics window (See Figure 7-10) is divided into 
three areas:

• Selection panel – contains buttons and check boxes for selecting, starting, and stopping
functions

• Graphic panel – depicts the path followed by test data during the current test 

• Duration and results panel – contains an input field for specifying how many blocks of da
use for a test that employs the DSU test pattern generator; displays Test Duration, Time
Remaining, and Test Results 

The Diagnostics window menu bar contains File and Navigate. The File menu has only the 
selection by which you dismiss the window. The Navigate menu also has a single selection: H
by which you can access a display of test results (see Figure 7-11) accumulated during the curren
diagnostic session. 
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Tests

The Diagnostics window selection panel lists three Tests to choose from, and three Patterns 
select for those tests that employ the DSU test pattern generator. There are two buttons: St
and Stop Test. 

The following Tests are available: 

• Line Loop (performed only with test pattern) 

• End To End (performed only with test pattern) 

• Dataloop (can be performed with or without test pattern) 

• Delay Test 

The Patterns are: 

• 511 bit 

• 2047 bit 

• 15 bit 

Each Test and Pattern is accompanied by a check box on which you can click to select it. The 
check boxes are grayed out when the selected Test cannot be combined with an internal test

Diagnostic Test Procedure

Perform the following steps to select and carry out a test procedure on the DSU. 

1. Click on the check box next to the selected test. If you are running the Delay Test, go to S

2. Under the Pattern heading, click on your selected pattern. The Dataloop test also suppo
selection None (for external data). 

3. If you are using an internally generated test pattern select, in the Test Blocks field, how 
data is to run before the test ends automatically. 

4. Click on the Start Test button. While the test runs, the graphic panel illustrates the data 
employed by the test. If you are using an internally generated test pattern, the Time Rem
field counts down from 100 to 0 percent. 

5. During a test that employs an internally generated test pattern the Test Results field disp
the number of errors detected; it displays In Loop when external data is in use. 

6. If you are using an internally generated test pattern, the test ends automatically when th
specified number of data blocks have run. For any other test, click on the Stop Test butto
end the procedure. 

Note Following any test except Dataloop a pop up window appears with the message Network element 
communication problem. Try again. 

The message results from the interruption caused by the test. Normal operation should resume whe
click on the OK box to dismiss the pop up.
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Figure 7-10 NMS 510 Diagnostics Window

Diagnostics Table

The table below briefly describes the available tests. 

Test Description

Line Loop 
(with Pattern)

DSU initiates a loopback at its network interface and activates its test 
pattern generator/checker.

End To End 
(with Pattern)

DSU activates its test pattern generator/checker and transmits the 
pattern on its link to the DSE. DSU checks for errors in the signal it 
receives, which is generated by the DSE. 

Dataloop 
(without 
Pattern)

DSU transmits a command on the link that causes the DSE to loop 
data back to the DSU; DTE or external test equipment at the DSU is 
responsible for generating and checking a test pattern. 

Dataloop
(with Pattern)

DSU transmits the loopback command to the DSE, and activates its 
test pattern generator/checker to transmit the pattern and check for 
errors in the signal it receives back. 

Delay Test DSU transmits and receives a test signal, which is looped back by the 
DSE; the DSU measures the round trip time (delay). 
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Diagnostics History

You can view a record of tests performed during the current diagnostic session by selecting H
from the Navigate menu in the Diagnostics window. The record appears as a listing in the 
Diagnostics History window (see Figure 7-11). 

Figure 7-11 Diagnostics History

The Diagnostics History displays information in five columns:

• Start Time – date and time test began 

• Test – name of the test 

• Pattern – test pattern used for the test; N/A when internally generated pattern is not use

• Test Blocks – number of data blocks sent during the test, applies only to tests with test p

• Test Results – “Idle: n/n Bit/Block Errors” for a completed test with test pattern; “Not in loo
[STOPPED]” for a completed loop test without test pattern; “TEST STOPPED” for any te
with test pattern that was ended by the Stop Test button; “n ms.” for Delay Test

To close the Diagnostics History window, click on either the OK button or the pushpin icon in
upper left corner of the window. During an on-going diagnostic session you can close and re
the Diagnostics History window without loss of display data. 

The application clears the Diagnostics History when you exit from the Diagnostics window. 

Miscellaneous Functions
The submap Misc Menu has selections for Front Panel Poll Rate and Note Pad. These sele
access the same applications that are described in Chapter 2. 
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Glossary of Terms

A
AAL
Abbreviation for ATM Adaptation Layer

AAL1 
ATM Adaptation Layer 1 defined in ITU-T I.363.1. The type of ATM adaptation principally us
for circuit emulation services over an ATM network 

AAL2 
ATM Adaptation Layer 2 defined in ITU-T I.363.2. The type of ATM adaptation used for Varia
Bit-Rate Voice-Over-ATM services 

AAL5 
ATM Adaptation Layer 5 defined in ITU-T I.363.5. The type of ATM adaptation principally us
for frame and packet transport over an ATM network

AC
Alternating Current

ACF
Access Control Field (first byte in ATM header)

A/D
Analog to Digital (typically conversion of voice to digital format)

ADPCM 
Adaptive Differential Pulse Code Modulation. A compression algorithm for voice as defined 
ITU-T G.726 

AFI
Abbreviation for Authority and Format Identifier

ALS
Active Line State

ANSI
Abbreviation for American National Standards Institute

APEX
Abbreviation for Advanced Packet Exchange
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API
Abbreviation for Application Programming Interface

ARP
Address Resolution Protocol

ARQ
Automatic Repeat reQuest

ASCII
American Standard Code for Information Interchange

ASIC
Abbreviation for Application Specific Integrated Circuit

asynchronous
A data transmission timing technique that adds extra bits of information to indicate the begin
and end of each transmitted character

Asynchronous Transfer Mode (ATM)
The cell relay service that transfers mixed data types over a common communication medium
mixed data types include text, sound (voice and music) and graphics (video and still images

ATM
Abbreviation for Asynchronous Transfer Mode

AUI
Abbreviation for Attachment Unit Interface

AUU
ATM User-User connection (end to end)

B

B8ZS
Binary 8 Zero Substitution

Bc
Committed Burst (amount of data allowed in time T=Bc/CIR without being marked DE)

BCC
Block Check Code

BCD
Abbreviation for Binary Coded Decimal 

BCN
Beacon (frames sent downstream when upstream input is lost)

Be
Excess Burst (transient capacity above CIR in Frame Relay network)
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BECN
Abbreviation for Backward Explicitly Congestion Notification

B-DCS
Broadband Digital Cross-connect System

BECN
Backward Explicit Congestion Notification 

BER
Bit Error Ratio

B-ICI
Broadband Inter Carrier Interface

B-ISDN
Broadband ISDN (generally ATM access at greater than 100 Mbit/s)

B-ISSI
Broadband Inter-Switching System Interface

BITS
Building Integrated Timing System

BIU
Basic Information Unit

bps
Bits Per Second

C

CAC
Connection Admission Control (process to limit new calls to preserve QoS)

CBR
Constant Bit Rate (service with low variation in cell delay)

CBX
Computerized Branch eXchange

CDV
Cell Delay Variation (ATM UNI traffic parameter)

CE
Circuit Emulation

CES
Circuit Emulation Service
058R735-V300 GDC TEAM 521 for HP OpenView/UNIX, Version 3.0.0 G-3
Issue 2 Operation Manual



Glossary of Terms

-0s 

a 
s, 
&T 
CIR
Committed Information Rate (minimum throughput guaranteed by carrier)

CLP
Cell Loss Priority (signaling bit in ATM cell)

CODEC
COder-DEcoder (converts analog voice to digital and back)

CRC
Cyclic Redundancy Check

CSU
Channel Service Unit (interface to the T1 line that terminates the local loop)

D

DACS
Digital Access and Cross-connect System (digital switching device for routing T1 lines or DS
among multiple T1 ports)

dB
Decibel

DCC
Data Communications Channel (overhead connection in D bytes for SONET management)

DCE
Data Communications Equipment

DE
Discard Eligible (bit in header denoting lower priority when exceeding CIR or Bc)

DLCI
Abbreviation for Data Link Connection Identifier (address in Frame)

DDS1, DDS2, DDS3
North American hierarchy for digital transmission signals. The Dataphone Digital Service is 
private-line digital service offered intra-LATA by BOCs, inter-LATA by AT&T Communication
with data rates typically at 2.4, 4.8, 9.6, and 56 kbps; now a part of the services listed by AT
under the Accunet family of offerings. 

DNA
Digital Network Architecture

DSL
Digital Subscriber Line

DSP
Abbreviation for Domain Specific Part
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DSS1
D-channel Signaling System 1 (access protocol for switched connection signaling)

DSU
Data Service Unit (converts RS-232 or other terminal interface to line coding for local loop 
transmission)

DTE 
Data Terminal Equipment

DXD
Abbreviation for Dual Frame Relay/Frame Transport Daughter board

E

E1, E2, E3
International hierarchy for digital transmission

EC
Error Correction (process to check packets for errors and re-transmit if necessary)

ECC
Error Checking Code (allows receiver to test for errors)

ECHO
European Clearing House Organization

ECN
Explicit Congestion Notification (network warning to terminals of congestion by setting bits i
header)

EFI
Errored Frame Indicator (ATM on fiber channel)

EIA
Abbreviation for Electronic Industries Association.

ESF
Extended Superframe

F

FC
Frame Control (field to define type of frame)

FCS
Abbreviation for Frame Check Sequence

FECN
Abbreviation for Forward Explicitly Congestion Notification (signaling bit in frame relay head
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Frame Check Sequence (FCS)
The field in a transmitted frame that is used for frame error checking.

FE1
Fractional E1

FIFO
First In First Out (buffer type that delays bit stream)

FPDU
Frame Protocol Data Unit

FR
Frame Relay (interface to simplified packetized switching network)

FT1
Fractional T1

FTP
File Transfer Protocol (TCP/IP)

G
G.703
Abbreviation for ITU recommendation for physical/electrical characteristics of hierarchical di
interfaces

G.804
Abbreviation for ITU recommendation for ATM cell mapping over Plesiochronous Digital 
Hierarchy (PDH)

Gbit/s (Gbps)
Abbreviation for Gigabits per second

GCRA
Generic Cell Rate Algorithm (how an ATM entity measures / controls negotiated service usa

GDC 
General DataComm

GFC
Generic Flow Control (first half-byte in ATM header at UNI)

GUI
Abbreviation for Graphical User Interface

H
H.261
Abbreviation for ITU recommendation for CODEC (coder/decoder) for audio visual services
x 64 kbit/s
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HCDS

High Capacity Digital Service (Bellcore T1 specification)

HCS

header Check Sequence (CRC on header fields only - HEC for ATM)

HDLC

Abbreviation for High-Level Data Link Control (layer 2 full duplex protocol)

HEC

Header Error Control (ECC in ATM cell for header- not data)

HSSI

Abbreviation for High Speed Serial Interface

I

ICD

Abbreviation for International Code Identifier

IDI

Abbreviation for Initial Domain Identifier

IEEE

Institute of Electrical and Electronic Engineers

IETF

Abbreviation for Internet Engineering Task Force

ILMI

Interim Local Management Interface (ATM addressing process)

IISP

Interim Interswitch Signaling Protocol

IP

Abbreviation for Internet Protocol

IPX

Internetwork Packet eXchange 

ISDN

Integrated Services Digital Network

ITU

Abbreviation for International Telecommunications Union
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JPEG
Joint Photographic Expert Group (part of ISO that defined digital storage format)

kbit/s (kbps)
Abbreviation for kilobits per second

L

LAN
Abbreviation for Local Area Network.

LED 
Light Emitting Diode

LMI
Abbreviation for Local Management Interface

LIM
Abbreviation for Link Interface Module

Local Area Network (LAN)
A type of high-speed data communications arrangement wherein all segments of the transm
medium (typically, coaxial cable, twisted-pair wire, or optical fiber) are under the control of t
network operator.

M

MAC
Medium Access Control (lower sublayer of the OSI data link layer)

Mbit/s (Mbps)
Abbreviation for Megabits per second

MBS
Maximum Burst Size (number of cells that may be sent at PCR without exceeding SCR)

MIB
Abbreviation for Management Information Base (OSI defined description of a network for 
management purposes)

MPEG
Motion Photographic Expert Group (part of ISO that defined digital video storage format)

MS
Abbreviation for APEX Adaptation slot controller (hardware segmentation and reassembly)
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MUX
Multiplexer

N

NAU
Network Addressable Unit (addressable device or process running an SNA protocol)

NEBS
Network Equipment Building Systems

NIC
Network Interface Card (enables workstation to connect to network)

NMS
Abbreviation for General DataComm Network Management System. 

NNI
Network to Network Interface (between carriers or carrier to private network)

NTM
Node Timing Module

NSAP
Network Service Access Point (logical address of a “user” within a protocol stack)

O

OAM
Operations Administration and Maintenance

OC-1
Optical Carrier level-1 (SONET rate of 51.84 Mbit/s, matches STS-1)

OC-3
Optical Carrier level-3 (SONET rate of 155.52 Mbit/s, matches STS-3)

P

PBX
Private Branch eXchange

PCM
Pulse Code Modulation (standard digital voice format at 64 kbit/s). The basic modulation sc
for transporting voice channels in 64 Kbps timeslots 

PCR
Peak Cell Rate (ATM traffic parameter applied per VC, VP or channel)
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PDH
Pleisiochronous Digital Hierarchy (multiplexing scheme from T1 to T3 and higher)

PDU
Protocol Data Unit (information packet passed at one level between different protocol stack

PHY
PHYsical layer (level-1 of the OSI model)

PLCP
Abbreviation for Physical Layer Convergence Protocol (part of PHY that adapts transmissio
medium to handle a given protocol sublayer)

PMP
Point-to MultiPoint (broadcast connection)

Postal, Telegraph, and Telephone (PTT)
Government authority or agency that typically operates the public telecommunications netw
sets standards and policy, and negotiates communications issues internationally for a partic
country; not found in the United States

PRC
Primary Reference Clock (GPS-controlled rubidium oscillator used as stratum 1 source)

PSU
Abbreviation for Power Supply Unit

PTT
Abbreviation for Postal, Telegraph, and Telephone

Permanent Virtual Connection (PVC)
A dedicated logical circuit between two nodes in a point-to-point ATM network. 

Q

QED
Abbreviation for Quad Ethernet Daughter board

QoS (QOS)
Quality of Service

R

RFC
Abbreviation for Request For Comment (RFC1212, RFC1215, etc. on Internet Standard)

RTS
Residual Time Stamp (ATM control information to support CBR service)
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SAAL
Signaling ATM Adaptation Layer

SAP
Abbreviation for Service Access Point 

SCR
Sustained Cell Rate (ATM traffic parameter)

SDH
Abbreviation for Synchronous Digital Hierarchy (Europe)

SDLC
Abbreviation for Synchronous Data Link Control

SDH
Synchronous Digital Hierarchy (digital multiplexing plan where all levels are synched to the s
master clock)

SDT
Structured Data Transfer

SDU
Service Data Unit (information packet or segment passed down to become the payload of th
adjacent lower layer in a protocol stack.

SLIP
Abbreviation for Serial Line Interface Protocol

SNA
Abbreviation for Systems Network Architecture. In IBM networks, the layered logical structu
formats, protocols, and procedures that govern information transmission

SNMP
Abbreviation for Simple Network Management Protocol

SONET
Abbreviation for Synchronous Optical Network (North America)

Soft Permanent Virtual Connection (SPVC)
Soft Permanent Virtual Circuit. A logical circuit similar to PVCs but set up on a call-by-call ba
A switched connection originating and terminating within the APEX network that appears as a
to the endstations.

Switched Virtual Circuit (SVC)
A dynamically signaled logical end-to-end connection between two end-points in a network,
established as needed by the end-user device 

Synchronous Data Link Control (SDLC)
Bit-oriented IBM version of the HDLC protocol; the mainstay of SNA communications. 
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ATM 

to 
T

T1, T2, T3
North American digital transmission hierarchy

TAXI
Abbreviation for Transparent Asynchronous Transmitter/Receiver Interface

TCP/IP
Transmission Control Protocol/Internet Protocol

TDM
Abbreviation for Time-Division Multiplexer/Multiplexing

TFTP
Abbreviation for Trivial File Transfer Protocol

TIA
Abbreviation for Telecommunications Industry Association

U

UNI
Abbreviation for User-Network Interface

UDT
Unstructured Data Transfer

V

VBR
Variable Bit Rate (ATM traffic parameter, packetized bandwidth on demand, not dedicated). 
Traffic Class offering statistical multiplexing gains for bursty applications in the network.

VC
Virtual Circuit 

VCC
Virtual Circuit Connection. An ATM logical connection used to connect end-system devices 
each other in a connection oriented network. A VCC may be a PVC, SVC, or an SPVC.

VCI
Abbreviation for Virtual Channel Identifier

Virtual Channel Identifier (VCI)
Logical, link-to-link channels between two ATM nodes

VP
Virtual Path (for many VCCs between concentrators)
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(DTE) 
otocol 
VPC
Virtual Path Connection (between switches)

Virtual Path Identifier (VPI)
Groups of logical, link-to-link virtual channels between two ATM nodes

VTOA 
Voice Telephony Over ATM

W
WAN
Wide Area Network

X
X.25
A CCITT recommendation that specifies the interface between user data terminal equipment 
and packet-switching data circuit-terminating equipment (DCE); the physical and message pr
for packet switched data

XH
APEX 6.4-Gbit/s switching fabric

XM
APEX 1.6-Gbit/s switching fabric 
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Access to Functions6-1
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Configuration 6-10
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